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Introduction 
 

MA-5 Authoring Tool is the application software for authoring, correcting, and verifying the contents for 
portable terminals. The operating systems for running this software include Windows®2000 and 
Windows®XP. 

 
The use of this application allows a conversion from SMF (Standard MIDI file) into MLD format (*.mld), 

editing of voices, editing of management information, and verification of voice generation by MA-5 
emulator. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Recommended Operating Environment 
 

The recommended operating environment of this authoring tool is as follows. 
 
Compatible Operation System Microsoft® Windows® XP 

Microsoft® Windows® 2000 
CPU / Clock Pentium®, Celeron™, or compatible processor/ 400MHz or more 
Memory 64MB or more 
Required hard disk space 40MB or more 
 
 
【Note】 All names of products that are presented in this manual are trademarks and registered trademarks of 

their companies respectively. 
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1. About MA-5 Authoring Tool 
 
 
 
Independence of MA-5 Authoring Tool and Sequencer 

 
MA-5 Authoring Tool is independent application software that is used together with general-purpose MIDI 

sequencer. Therefore, the user is allowed to select the most familiar sequencer. All operations up to 
conversion to MLD file (*.mld) can be made by performing sequence using your sequence software, and 
performing editing of voices and editing of management information using MA-5 Authoring Tool. 

 
 
 
Maximum of Enabling Simultaneous Voices 
   

  MA-5 Authoring tool has “FM16 mode”, “FM32 mode”, and “ALL64 mode.” The maximum of enabling 
simultaneous voices depends on the mode setting, or whether using or not using AL Channel. 

 
 
The maximum of enabling simultaneous voices without AL channel are described as follows. 
 FM Synthesizer PCM Synthesizer Stream PCM Total 
FM16 Mode 16 16 2 34 
FM32 Mode 32 16 2 50 
ALL64 Mode  32 32 Disable 64 
 
 
The maximum of enabling simultaneous voices with AL channel are described as follows. 
 AL FM Synthesizer PCM Synthesizer Stream PCM Total 
FM16 Mode 1 15 15 2 33 
FM32 Mode 1 31 15 2 49 
ALL64 Mode  Disable 32 32 Disable 64 
 
 

In PCM synthesizer, you can use your favorite sound as the maximum of 16 notes (without AL channel) by 
FM16/FM32 mode and the maximum of 32 notes (with a size limitation) by ALL64 mode by reading the 
sound file (AIFF, WAVE) of 16bitPCM (encoding to 4bitADPCM) and by performing the frequency change, 
envelopes change, loop points setup, etc..  

 
 
 
Sequencer Direct MIDI Playback Function 
 

By directly playing back a file with your sequencer software, data, voice, and etc. can be confirmed. 
 
 
 
Event Viewer Function  

 
  This function allows confirming the event information on Score Window by reading SMF. In addition, it 
allows verifying the contents of SMF on “Event List Window” or “Piano Roll Window.” During a 
confirmation of the playback, “Piano Roll Window” advances synchronously. Furthermore, it allows 
performing an editing of music information.  
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Real Time Voice Editing Function 
 
  The read SMF data can be confirmed on “Event Viewer.” In a voice change, voice change in real time is 
possible. 

 
 
 
Stream PCM Pasting Function 

 
  By using this function, StreamPCM files to perform a synchronized playback with channel sequence can 
be read and assigned. In addition, the exclusive data to applicable channels and applicable notes can be 
transmitted to MA-5 emulator when it is assigned. For the reasons, an editing and verification of Stream 
PCM can be performed easily by combining the external MIDI sequencer with MA-5 Authoring Tool. 

 
 
 
AL Parameter Equip Function 
 

The effect of filter is obtained by setting “AL parameters” in FM voices, PCM voices, and Noises. 
 
 
 
Realize the Various Sounds Easily by Using Voice Library 

 
Voice Libraries (VLF-MA3/VLP-MA3/VLP-MA5/VLA-MA5/VLW-MA3) which are recorded various 
sounds are attached in this application. 

 
・ “VLF-MA3” is an extended voice library of FM voice, and it is able to extend voices which differ 

from default voices, easily. 
 

・ “VLP-MA3”and “VLP-MA-5” is the PCM voice library, and it can easily realize real sounds that 
differ from FM. 

 
・ “VLA-MA5” is the voice library with AL parameters; in addition, the sound which has the filter effect 

to FM voice and PCM voice can be used. 
 

・ “VLW-MA3” is the Ethnic Library; in addition, it can expand the sounds for the folk instruments.  
 
By using these three voice libraries, the various sounds are easily realizable. 

For details about the registration method of each voice libraries etc., see the manual attached with library. 
(VLF-MA3_v***.pdf, VLP-MA3_v***.pdf, VLP-MA5_v***.pdf, VLA-MA5_v***.pdf, 
VLW-MA3_v***.pdf) 
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2. How to start up the MA-5 Authoring Tool?  
 

  This chapter describes the installation procedures for MA-5 Authoring Tool and steps to start up the MA-5 
Authoring Tool. 
 

 
 

2.1. Installation of MA-5 Authoring Tool 
 

This section describes the installation procedure for MA-5 Authoring Tool. 
 
 
 
 

1. Double click “setup.exe” icon. 
 
 
 

2. “Setup Wizard” dialog is displayed. 
 
 
 

3. Click “Next” on “Setup Wizard” dialog. 
 
 
 

4. Then, “Select Installation Folder” dialog appears. 
 
 
 

5. Select the folder in which the application will be installed. Then, 
click “Next.” 

 
 
 

6. “Confirm Installation” dialog appears. 
 
 
 

7. Select “Next”, then, installation is started. When the installation 
is completed, “Installation Complete” dialog is displayed. 

 
 
 

8. Click “Close” on “Installation Complete” dialog. 
 
 
 

9. Installation is now completed; in addition, a shortcut icon 
“ATS-MA5-S” is also created on your desktop. 
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2.2. Start-up of Authoring Tool 
 

  After the installation of MA-5 Authoring Tool was completed, MA-5 Authoring Tool can be started up 
with the following procedures.  

 
 

 
 
 

 
 
 
 
 
 

 

 

 

 

 

  

 

 

3. Program is started up normally, 
and then Application Window is 
displayed. (See, p.9) 

1. Double-click “MA-5_AT.exe” 
that can be found in “Exe” folder 
or double-click the shortcut of 
“AT-MA5-S” icon which was 
created on your desktop at the 
installation. 

 

Double Click 

2. Startup displays are 
appeared in order. 
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3. Reference  
 

This chapter describes the names and functions of each window, bar, and menu provided in MA-5 
Authoring Tool. 

 
 

3.1. Application Window 
 

Each edit windows are opened on this “Application Window.” This window provides “Menu bar”, 
“Control bar”, “Volume bar”, “LED/MTR Bar”, “Preference Bar”, “Report bar”, “Tool bar”, “Density 
Report Bar”, and “Status bar” that are applicable commonly to all edit windows. The Menu bar, Volume bar, 
LED/MTR Bar, Preference Bar,Tool bar, Preference Bar, and Control Bar are used to select or execute 
various functions by clicking or dragging. In addition, Report Bar, Density Report Bar, and Status Bar show 
the present status. 

 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
【Note】 The Control bar, Volume bar, Report bar, Tool bar, Preference Bar, LED/MTR Bar, Density Report Bar, 

and Status Bar can be displayed or hidden as necessary. 
 
【Note】 By clicking “View” menu on Menu bar, a pull-down menu is displayed. By clicking a name of Tool 

bar, Status Bar, Report Bar, Volume Bar, Preference Bar, LED/MTR Bar, Density Report Bar, and/or 
Control Bar and placing a check, Tool bar, Status Bar, Report bar, Volume bar, Preference Bar, 
LED/MTR Bar, Density Report and Control Bar are displayed on Application menu. Conversely, by 
clicking the name of Control bar, Volume bar, Report bar, Toolbar, Preference Bar, LED/MTR Bar, 
Density Report Bar, and/or Status Bar once again, these windows are hidden from Application menu. 

Menu Bar  

Control Bar  

Volume Bar  

Report Bar 

Tool Bar 

Status Bar 

Preference Bar 

Density Report Bar 

Application Window 

Figure. 3-1 Application Window 

LED/MTR Bar 
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3.2. Title Bar 
 

  “Title Bar” on the “Application Window” displays the name and the location of a file which is presently 
opened in MA-5 Authoring Tool. The Title Bar of each “Edit Window” displays the name of each window. 
Functions provided by “Title Bar” are described as follows.  

 
 
 
 
 
 
 
 

 
 
 
3.2.1. System Menu 
 

  By clicking the “Application Icon” located on the left end on “Title Bar”, this “System Menu” is opened. 
Function provided in this menu as follows. 

 
 
 
 
 
 
 
 

No. Name Description 

1 Application icon  By clicking this icon, System menu is opened. 
(For details, see “3.2.1System Menu.”) 

2 Minimize button By clicking this button, windows are minimized (to make it an icon).

3 Maximize button/Undo (Minimize) 
button 

By clicking this button, windows are maximized. Window is restored 
to the original size by clicking this button once again. 

4 
Close button By clicking this button, windows are closed. In case of “Application 

Window”, windows are closed and application is also ended. In case 
of “Edit Windows”, each window is closed one by one. 

No. Name Description 
1 Restore When the size of window has been changed by size 

change etc., the window is restored to original size by 
clicking this function. 

2 Move Mouse pointer is changed to the moving tool by 
clicking this function. Use this pointer to move the 
windows by clicking & dragging the title bar of 
windows. The maximized windows cannot be moved.

3 Size Mouse pointer is changed to the size-change tool. Put 
this pointer on the upper, lower, left and right side 
lines of the window, and clicks and drugs the line to 
change the size of the window. The maximized 
window cannot be changed. 

4 Minimize Windows are minimized (to make it an icon) 
5 Maximize Windows are maximized. If the window is already 

maximized, this function cannot be selected. 
6 Close 

(Alt+F4) 
(Ctrl+F4) 

Windows are closed by clicking this function. In case 
of “Application Window”, all windows are closed 
and application is also ended. In case of “Edit 
Window”, each window is closed one by one. 

7 Next (Ctrl+F6) If multi-Edit Windows are opened on Application 
Window, a Window in active can be changed by 
clicking this button. This function is only available on 
the System menu of Edit Window. 

1 2

3

4
Figure. 3-2 Title Bar 

Figure. 3-3 System Menu 

1 
2 
3 
4 
5 

6 

7 
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3.3. Menu Bar 
 

In Manu Bar, the following menus are provided to execute and control various functions. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.3.1. File Menu 
 

A series of operation such as open, close, save, and end of files can be performed with this menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Function Name Contents 
1 New Creates a new file. 

SMAF including StreamPCM or 
HV can be created without reading 
SMF. 

1 Open (Add File List)… 
(Crtl+O) 

Opens a MLD file into File List Window. 
(*.mld) 

2 Close Closes a SMF file. (*.mid) 
3 Save (Ctrl+S) Saves a file in MLD file format. (*.mld) 
4 Save As… Saves a MLD file with another name. 

(*.mld) 
5 Import From SMF… (Ctrl+L) Loads a SMF file. (*.mid) 
6 Reload from SMF… (Ctrl+R) Reloads a SMF file (*.mid). 

If the file contains an event related with 
StreamPCM, a confirmation message 
about updating is displayed. 
Reloads a SMF file. (*.mid) 

7 Export to SMF… Saves a file in SMF format (*.mid) 
Only the events described in the 
“Contents Authoring Guideline” is 
output. Even the file which does not 
contain note-events allows to be saved. 

8 Open Voice File Loads a MA-3 voice file (*.vm3) and 
MA-5 voice file (*.vm5). 

9 Save Voice File Saves a file in MA-3/MA-5 voice file 
format (*.vm3/.vm5). 

10 Exit Exists from MA-5 Authoring Tool. 

File Edit View Window Option 

Help 

Menu Bar 

Figure. 3-4 Menu Bar 

See, “p.12” 

See, “p.13” 

See, “p.13”

See, “p.14” 

See, “p.15” 

See, “p.15” 

1 
2 

3 
4 

5 

8 

10 
9 

11 

Figure. 3-5 File Menu 

6 
7 
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3.3.2. Edit Menu 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.3.3. View Menu 
 

Each bar is displayed and/or hidden from Application Window by left clicking on the name of each bar to 
place/replace a check mark. Check mark is displayed to the menu by which function has been activated. For 
details about each function in View Menu, see the following table. 

 
 
 
 
 
 
 
 
 
 
 

No. Function Name Contents 
1 Undo 

(Ctrl+Z) 
In Voice Assign Map, the voice parameter 
updated by paste operations is returned to the 
parameter before the operation. 

2 Redo 
(Ctrl+Y) 

The voice parameter updated by Undo 
operation is returned to the parameter before 
the operation. 

3 Copy 
(Ctrl+C) 

Copies voices which is selected in the Voice 
List or Voice Assign Map. When nothing is 
selected, it is displayed with gray color. 

4 Paste 
(Ctrl+V) 

Pastes the copied voices on the designation 
locations of Voice list or Voice Assign Map. 

5 Import from Voice List… When the voice is registered in Voice Assign 
Map, the voice specified by Bank (M/L) and 
Pch# is stuck into Voice Assign Map from 
Voice List.  

6 Export to Voice List… When the voice is registered in Voice Assign 
Map, the voice specified by Bank (M/L) and 
Pch# is stuck into Voice List from Voice 
Assign Map. 
[Note] Voice data cannot be exported to 
the preset voice bank area. 

No. Function Name Contents 
1 Control Bar Switches a display/non-display of Control Bar. 

(For details, see “3.4Control Bar”) 
2 Volume Bar Switches a display/non-display of Volume Bar. 

(For details, see “3.5Volume Bar”) 
3 Report Bar Switches a display/non-display of Report Bar. 

(For details, see “3.6Report Bar”) 
4 Tool Bar Switches a display/non-display of Toolbar. 

(For details, see “3.7Tool Bar”) 
5 Status Bar Switches a display/non-display of Status Bar. 

(For details, see “3.11Status Bar”) 
6 LED/MTR Bar Switches a display/non-display of LED/MTR Bar. 

(For details, see “3.8LED/MTR Bar.” 
7 Density Report Bar Switches a display/non-display of Density Report Bar. 

(For details, see “3.10Density Report Bar”) 
8 Preference Bar Switches a display/non-display of Preference Bar. 

(For details, see “3.9Preference Bar”) 

1 
2 

3 

5 
4 

6 

Figure. 3-6 Edit Menu 

1 
2 
3 
4 
5 
6 
7 

Figure. 3-7 View Menu 

8 
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3.3.4. Window Menu 
 

In Window menu, display/non-display arrangement of each window can be controlled. By placing a 
check on the name of each window, windows are opened on Application Window. Check mark is displayed 
to the menu by which function has been activated. For details about each function in Window Menu, see the 
sections for each window. In addition, windows and dialogs displayed on “Application Window” can be 
arranged by selecting “Cascade”, “Tile”, and/or “Arrange Icons.”  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Function Name Contents 
1 Cascade Displays windows in piles. 
2 Title Displays windows in a line. 
3 Arrange Icons Arranges the minimized windows on the bottom of 

“Application Window.” 
4 Voice Assign Map Displays Voice Assign Map. 

(For details, see “4.4Voice Assign Map.”) 
5 Stream PCM Assign Map Displays Stream PCM assign map. 

(For details, see”4.5StreamPCM Assign Map.”) 
6 Voice List Displays Voice list. 

(For details, see “4.3Voice List Window.”) 
7 Mixer Displays Mixer Window. 

(For details, see “4.6Mixer.”) 
8 Event Density Displays Event Density window 

(For details, see “4.7Event Density.”) 
9 Edit Information Displays management information dialog. 

(For details, see “4.9MLD Information.”) 
10 Velocity Change Displays Velocity Change dialog. 

(For details, see “4.8Velocity Change.”) 
11 File Access Log Displays File Access Log window. 

(For details, see “4.10File Access Log.”) 
12 File List Displays MLD File List window. 

(For details, see “4.1File List Window.”) 
13 Transpose Displays the Transpose window. 

(For details, see 4.11 Transpose.”) 
14 List of Windows Lists the windows currently opened in Application 

Window. In addition, a window currently active is 
shown with checked mark as shown like in figure. 
Moreover, the selected window will become an active 
condition if optional windows are chosen from a list. 

1 

3 
2 

4 
5 

6 
7 

8 
9 

10 
 11 

12 
13 

Figure. 3-8 Window Menu 

14 
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3.3.5. Option Menu 

 
  In “Option Menu”, basic operation-environment for working on Authoring Tool, etc. can be set up. For 
details, see the section for each function. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.3.6. Help Menu 
 

  In “Help Menu”, following functions which supports user’s operations are provided. For details, see the 
following sections for each function. 

 
 
 
 
 
 
 
 
 
 
 
 
 

No. Function Name Contents 
1 Preference Opens preference dialog. 

(For details, see “4.12Preference.”) 
2 Reset This function is not available. 
3 DVA Checker DVA checker window is opened, and then the 

maximum number of pronunciation in data can 
be checked. 
(For details, see “4.13DVA Checker”) 

No. Function Name Contents 
1 Authoring Tool 

Help… 
Displays “MA-5 Authoring Tool User’s Manual.”

2 about MA-5 
Authoring Tool 

Displays “about MA-5 Authoring Tool.” 
(For details, see “4.14about Authoring Tool.”) 

3 Tools for SAMSUNG 
(Website) 

URL 
http://smaf-yamaha.com/tools/samsung/ 

1 
2 

3 

Figure. 3-9 Option Menu 

2 
1 

3 

Figure. 3-10 Help Menu 

http://smaf-yamaha.com/tools/samsung/
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3.4. Control Bar 
 

Control Bar is a functional group to display or control the contents of data which was converted from SMF 
file (*.mld). A series of operation from playback to stop of data can be performed by checking the musical 
piece data. Descriptions about each functions, see the following table. For details, see the following table. 

 
 
 
 
 
 
 

 
【Note】 The Repeat setup, Playback mode change of Phrase List, Tempo Control Setup, and Key Control setup 

becomes valid only when Authoring tool is used, and does not reflect to MLD files. Time base is 
displayed per 1Tick in (ms) unit. 

 
 
 

3.5. Volume Bar 
 

Volume bar is a function to set the playback volume, speed, height of key, etc. of musical pieces in MA-5 
Authoring Tool. 

 
 
 
 
 
 

 
 
【Note】 Be sure to set up the Master volume to SMF. If Master volume is not defined, a playback volume by 

sequencer and a playback volume by Authoring Tool may differ. 

No. Function Name Contents 
1 Rewind Playback bar is moved to the head of music. 
2 Stop Playback of music is stopped. 
3 Play Playback of music is started. 
4 Repeat (Rp) Repeat is designated. 
5 Playback Position Indicator Playback position is displayed. Arbitrary values can be input directly. Display unit is 

“ms.” 
6 Phrase List (Ph) Select a phrase list to be an object for playback. 

Change of playback mode is available. When “Overall” is selected, a music is played 
from head to end, and if “Partial” is selected, a music only a section specified by 
marker is played. For details about the specification of marker, see “Contents 
Authoring Guideline For MA-5 Authoring System.”  

7 TimeBase (TB) Time base is displayed. It displays a time about 1Tick in “ms” unit. 
8 Tempo Control (TC) Tempo control is displayed. Tempo value set in the read data is possible to be changed 

and played back by “70% - 130%”of a rate. Default is “100.” 
9 Key Control (KC) Displays the key control, which can be changed from “+12 to -12.” Default is “0.” 

Only the channel which uses the tone of a normal bank receives key control. The 
channel which uses the tone of a drum bank does not receive key control. 

No. Function Name Contents 
1 MV (Master Volume) Displays the maximum value of Master volume which was input in music. 

When the master volume of data to input is not defined, the master volume is 
automatically set to “100.” 

1 3 2 4 5 6 7 8 9 

Figure. 3-11 Control Bar 

1

Figure. 3-12 Volume Bar 
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3.6. Report Bar 
 

In “Report Bar”, RAM size used in music is displayed. The unit is “Byte.” 
 

 
 
 
 
 
 
 

No. Function Name Contents 
1 RS (RAM Size) Total RAM Size in music is displayed by byte unit. 
2 RS (for JAVA) Total RAM size on a piece of music used in a Java application is 

displayed. 
 
 
 

RAM Size Check Timing 
When “OK” button of VoiceEdit dialog is clicked. 
In case of SMF Import 
In case of SMF Reload 
In case of Voice Paste to VoiceAssignMap 
In case of import from Voice List 
When “OK” of Preference is selected. 
When Reserve setting in Piano Roll/Stream PCM Edit View are changed. 

 
 
 
 
 
3.6.1. About RAM Size 
 

  The total RAM size of MA-5 is 8192-byte, and thus, if it exceeds the capacity, it cannot play back the 
music. Authoring Tool calculates the used RAM size in music, in addition, if it exceeds 8192-bytes, an error 
message will be output. Size calculation serves as the following sum totals. 

 
  

Size List 
Registration of Voice Parameter  FM2op  : 16 bytes / one voice 

FM4op : 30 bytes / one voice 
PCM  : 14 bytes / one voice 

Registration of AL Parameter AL+FM2op : 16 bytes / one voice 
AL+FM4op : 30 bytes / one voice 
AL+PCM  : 14 bytes / one voice 
AL+Noise  : 14 bytes / one voice 

Registration of PCM Voice Waveforms Bytes number in data section 
(1 byte will be added if it is an odd number.) / one waveform 

Registration of FM Fundamental Waveform 2048 byte / one waveform 
Registration of Stream PCM Waveform When not used (No Reserved) / 0 byte 

When max. number of voices pronouciation number is “1.”  
(1 Voice Reserved) /1024 bytes 
When max. number of voices pronouciation number is “2.” 
(2 Voice Reserved) /2048 bytes 

 

1

Figure. 3-13 Report Bar 

2
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3.7. Tool Bar 
 
Tool Bar contains a series of functions which are also provided in “File Menu”, “Edit Menu”, etc. 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
【Note】 It is only applicable for “SMF Format 0” and “SMF Format 1.” 

 
 
 

No. Function Name Contents 
1 New Creates a new file. 

SMAF including StreamPCM or HV can be created without reading 
SMF.  

2 Open (Add File List) Registers a MLD file into file list. Opens the MLD file (*.mld) 
3 Import from SMF Imports a SMF (*.mid). Refer to the following “Note.” 
4 Reload from SMF Reloads a SMF (*.mid). 
5 Save Saves a MLD file (*.mld). 
6 Undo Voice data paste is undone. 
7 Redo Voice data paste is redone. 
8 Copy Copies a voice data. 
9 Paste Pastes a voice data. 
10 Voice List Displays the Voice List Window. 

(For details, see “4.3Voice List Window.”) 
11 Mixer Displays the Mixer Window. 

(For details, see “4.6Mixer.”) 
12 Information Displays the Information Window. 

(For details, see “4.9MLD Information.”) 
13 Help Opens the “MA-5 Authoring Tool User’s Manual.” 
14 Voice Assign Map Displays the Voice Assign Map. 

For details, see “4.4Voice Assign Map.”) 
15 Import from Voice List Imports voices with the same bank number and the same voice number to the voice list 

in the Voice Assign Map. 
16 Export to Voice list Exports voices with the same bank number and the same voice number from the voice 

list in the Voice Assign Map. 
[Note] Voice data can not be exported to the preset voice bank area. 

17 Stream PCM Assign Map Displays Stream PCM Assign Map. 
(For details, see “4.5StreamPCM Assign Map.”) 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 14 16 

Figure. 3-14 Tool Bar 

17 
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3.8. LED/MTR Bar 
 

LED/MTR status returned by polling which opposes to Emulator can be displayed and set up with this bar. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

3.9. Preference Bar 
 

This is a dialog bar to set the MA-5 Authoring Tool operational environment. 
 
 
 
 

 
 
 
 
 
 

No. Function Name Contents 
Switches FM mode. When a music-data is loaded in Authoring Tool, FM mode can not 
be changed. In that case, be sure to close the file once, and then reset the contents 
mode. 
FM16 mode 
This is a mode to generate 16-tone by using 2-operator/4-operator voices and PCM 
voice. 
FM32 mode 
This is a mode to generate 32-tone by using 2-operator voices and PCM voice. 
ALL64 mode 

1 Contents Mode 

This is a mode to generate 32-tone by using 2-operator voice as FM section and 
generate 32-tone as PCM section. 

 
 

No. Name Description 
1 LED Sets the blinking frequency of LED. The frequency of polling is 0.1sec. 

One of “Default (No Blink)”, “18Hz”, “16Hz”, “12Hz”, “8Hz”, or “4Hz” is selectable. 
2 MTR Sets the blinking frequency of MTR. The frequency of polling is 0.1sec. 

One of “Default (No Blink)”, “2.25Hz”, “2.0Hz”, “1.5Hz”, “1.0Hz”, or “0.5Hz” is selectable.

1

Figure. 3-16 Preference Bar 

1 2

Figure. 3-15 LED/MTR Bar 
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3.10. Density Report Bar 
 

This bar shows the event density information in music data. 
 
 

 
 
 
 
 
 
 
 

 
 
【Note】 When the value of Average Density exceeds “500 byte/s,” warning is displayed and the “AD” column of 

“Status Bar” blinks in red. 
 
【Note】 When the value of Max Density exceeds “1000 byte/s,” warning is displayed and the “MD” column of 

“Status Bar” and the “MDP” column blink in red. 
 
【Note】 While one of the “AD”, “MD” or “MDP” is blinked in red, it cannot save as a MLD file. 

 
 
 
 
 
3.10.1. Calculation Method of Event Density 
 

The size consumed by MIDI event is differed. When an error comes out by event density, it is necessary 
to cut the event in reference to “4.7Event Density.” 

 
 
 

The number of consumption bytes of a MIDI event 
Note Event  6Byte 
Control Chan 3Byte 
Program Change 2Byte 
Pitch bend 3Byte 
Exclusive Message Byte in Data Section + 2 (F0, F7) Byte 

 
 

No. Function Name Contents 
1 AD (Average Density) Converts the event density in the read music, which put through one 

music, to MIDI byte numbers; and then, it is displayed. The unit is 
“Byte/sec.” (One musical note is counted as 6-Byte.) 

2 MD (Max Density) Displays the event density per unit, which is the highest in one music. The 
unit is “Byte/sec.” 

3 MDP (Max Density Position) Displays the position which has the highest event density in music. 
The unit is “ms.” 

1 2 3

Figure. 3-17 Event Density Report Bar 
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3.11. Status Bar 
 

In “Status Bar”, current status information of tool, contents information, etc. are displayed. 
 
 

 
 
 
 
 
 
 
 
 

 
 

No. Function Name Contents 
1 Status Display Displays the simple explanation about each buttons and functions in the position where the 

mouse is pointing. When nothing is pointed out, it shows “Ready.” 
2 TL (Total Length) Displays the “Actual Playing Total Time (end position)” in the read music. The unit is 

“ms.” The actual playing total time is the time from Start Point to Stop Point. 
The end position is displayed with Tick count from the head. 

3 SZ (Size) Displays the size of MLD when file is saved in MLD format (*.mld), or when MLD is read.

1 2 3

Figure. 3-18 Status Bar 
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4. Description of each Window  
 

This chapter describes the names and functions of each window provided in MA-5 Authoring Tool. 
 

 

4.1. File List Window 
 

MLD files can be loaded into this window as a list. 
A SMAF file can be dropped and added to the File List Window (multiple files can be dropped.) 
If one of MLD file loaded into File List Window is selected; in addition, “Play” in “Control Bar” is pressed, 
“Direct Play” is performed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Function Name Contents 
1 File Name Displays a file name of loaded MLD file. (*.mld) 
2 File Path Displays a file pass of loaded MLD file. (*.mld) 

 
 
 
 
 
 

1 2

Figure. 4-1 File List Window 

 Direct Play (Procedure of Playback a MLD File Format Music Data)

A. Open from File Menu 
B. Open from Tool Bar

C. Open from Voice List 

Open a music file (*.mld) using the mentioned three ways A, B, 
and C. When a music file is opened, it is assigned into File List.
Select one of music file (*.mld) which has been assigned on File 
List Window; then “Direct Play” is started by pressing “Play” 
button on “Control Bar.” 

Right click on a blank area on Voice List 
Window. Then, New/Delete popup menu is 
appeared. Select “New” from the menu. 
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4.2. Score Window 
 

Score Window is a window to display the data content of read SMF (*.mid) or MLD File (*.mld). 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 

No. Function Name Contents 
1 Piano Roll Displays the contents read into “Score Window” on “Piano Roll Window.” 
2 Event List Displays the data read into “Score Window” on “Event List Window.” 
3 CH Shows channel numbers. 
4 KS (Key Control Status) When Key Control is set up, specification of whether KeyControl is performed or not to the 

applicable channel is determined. 
By placing a check in the box, KeyControl becomes effective. 
In addition, in channels which use a voice of Normal bank (KS box is marked as “--“(default”)), 
KeyControl is valid. 
Conversely, in channels which use a voice of Drum bank, KeyControl is invalid. 

5 VS (Vibration Status) Designates whether Vibration Control is performed synchronizing with the data of applicable 
channel or not. Placing a check in the box to enable a Vibration. For VS setting of Stream PCM, 
refer to the following term “VS and LED Setup of Stream PCM”. 

6 LED Designates whether LED Control is performed synchronizing with the data of applicable 
channel or not. Placing a check in the box to enable LED. For LED setting of Stream PCM, 
refer to the following term “VS and LED Setup of StreamPCM”. 

7 Ctyp (Channel Type) Designates Channel Type for applicable channel. 
Clicking on the column of Ctyp of each channel changes the content as No-C, Melo, No-M and 
Ryh in this order. 

8 AL (Analog Like) By placing a check in this box, the channel can be set for AL voice channel. 
All voices of channel that has been set for AL voice channel become monophonic voices. After 
placing a check in the box of AL, and double-clicks any voice in voice assign map; in addition, 
places a check in the “Enable AL” of AL Voice Edit, and then, the effect of AL parameters can 
be obtained. 

9 Mute Mutes the channel by placing a check in the relevant channel. 
This setting is not reflected to MLD file. 

10 C (Change Flag) If the result shows difference when compared with voices that has the same bank number and 
voice number in the Voice List, a blue circle is displayed. When any of voices, which are 
different from the voice list in the relevant channel, exists, a blue circle is displayed. 

11 BM (Bank Select MSB) Displays BankSelect MSB at the head of voice. 
12 BL (Bank Select LSB) Displays BankSelect LSB at the head of voice. 
13 Pch (Program Change) Displays program change number at the top of voice. 
14 Name Displays name of voice at the head of voice. When a voice name is double-clicked, Voice Edit 

window will open. (Voice Edit window of built-in ROM voices cannot be opened.) 
15 Stream PCM Edit Displays Piano Roll Window (Stream PCM Edit View). 
16 Cue Point Setting 

Column 
Cue Point (Start point, End point) can be set by right-clicking on the column. 

1 2 

3 5 6 8 9 12 13

Figure. 4-2 Score Window 

7 11 144 10 

15
16 
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4.2.1. Setting of Cue Point (Start Point, Stop Point) 
 

The cue point can be designated on a dialog displayed by right-clicking on the Tick display area in the Score 
Window.  

 
 
 
 
 
 
 
 
 
 
 
 
 

Display colors for cue point 
 
 
 
 
 
 
 
 
 

The cue point can be moved while drugging it. 
 
 
 
 
 
 
 
 
 
 
 
 

Double-clicking on a cue point opens the cue point setting dialog shown below and allows inputting a 
position by Tick. 

 
 
 
 
 
 
 
 
 
【Note】 ・ A cue point cannot be created when any Note event is not present. 

・A position of the StartPoint cannot be created and moved after the StopPoint.  

・A position of the StopPoint cannot be created and moved before the StartPoint. 

StopPoint
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4.2.2. Piano Roll Window 
 

Displays the content of music data which was read into the “Score Window” on “Piano Roll Window.” 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4.2.3. VS and LED for StreamPCM  
 

The “Channel Status Window” is displayed by clicking the check box of “VS” or “LED” on the STM field 
of “Score Window.” “VS” and “LED” can be set to the channel into the note which plays Stream PCM is 
input. 
 

 

 

 

 

 

 

 

 

 

 

No. Function Name Contents 
1 Interval Display Displays the intervals of “Piano Roll Window.” 
2 [Ch1~16] and [All] part tabs By clicking each tab, a part to display on “Piano Roll Window” can be changed. 
3 Scroll buttons A part tab scrolls from side to side. Un-displayed part tab can be displayed. 
4 Horizontal zoom-in button By clicking, the display size of window can be enlarged horizontally. 
5 Horizontal zoom-out button By clicking, the display size of window can be decreased horizontally. 
6 Vertical zoom-in button By clicking, the display size of window can be enlarged vertically. 
7 Vertical zoom-out button By clicking, the display size of window can be decreased vertically. 
8 Note bar  Displays intervals and gate time of each MIDI note. 
9 Controller/Cue Point display  Displays a control change, pitch bend, or cue point (StartPoint, StopPoint) 

input into each part. See “4.2.1 Setting of Cue Point.”  
10 Stream PCM Edit View Assign of “StreamPCM” can be performed. 

2 3 4 5 6 7 

1 

9

10 

8

Figure. 4-3 Piano Roll Window 

 

  If any StreamPCM is not assigned in music, VS&LED check box on “STM” is not available. In order to set VS&LED 
to StreamPCM, any of StreamPCM must be assigned in music. For details about “how to assign a StreamPCM in 
music?,” see the next page “StreamPCM (WAVE  MLD) Conversion Procedure.” 
  When StreamPCM become assigneable, place a check on VS or LED check box, then “Channel Status” dialog is 
appeard on Application Window; in addition, both VS and LED can be set for StreamPCM. 
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StreamPCM (WAVE  MLD) Conversion Procedure 
 
1. Load a SMF which has no Midi-event or includes a note for Stream.  

* It can be also created from a new file. See [New] in “3.3.1 File Menu.” 
note for Stream (BANK/MSB125-Note Number 0 to 12, 92 to 110) 

2. Open the Piano Roll Window. The following windows are opened. 
*When note for Stream is contained in SMF, WAVEID which corresponds to the note number is automatically displayed. 

3. Register the WAVE Data of which a sampling frequency was optimized beforehand into StreamPCM Assign Map. Or load the existing 
StreamPCM File (*.sm3). 

*When a note for Stream is attached to SMF, be sure to register a WAVE corresponding to note number/WAVE ID. 
4. If Stream is newly added into music, Drag & Drop method shown blow can be used to assign. 
 
Stream PCM Edit View is a window to assign a Stream PCM to MLD. 
Since the maximum pronunciation of Stream PCM is two tones, it is divided into two levels (Upper/Lower). 
By dragging and dropping from Stream PCM Map to here, it becomes assignable. 
For details about how to assign the Stream PCM, see “4.5StreamPCM Assign Map.” 
By double-clicking the Stream truck, velocity conversion of Stream truck is possible; in addition, by right-clicking, Stream truck can be deleted. 
Moreover, displacement of position (Drag) and change of length (Drag adjustment) can be executable. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
No. Name Description 
1 Ch  The channel which inserts a StreamPCM event is selected. 

From newer to older, the number in channel without events is initial-displayed. 
2 Stream PCM Reserve Button  Sets the reserved number of Stream PCM. According to the reserved numbers, the 

amount of RAM consumption will be changed. 
Please refer to “3.6.1About RAM Size” for details. 

3 Stream PCM Track 
(Not Assigned) 

It is the Stream PCM track with which only the stream event exists and a voice is not 
assigned. It is indicated in gray. 

3 Stream PCM Track  
(Mono) 

It is the Stream PCM track of monophonic pronunciation.  
It is displayed in yellow-green. 

5 Audio Bar WaveID of a StreamPCM event and assigned channel number are shown. 
In the case of a monophonic, it is displayed in yellow-green; in addition, in the case of 
stereo, it is displayed in orange.  

 

 Nothing is assigned. 

Right click on blank area. Then, 
popup appears. Select “New”, 
and assign a Wave data. 

Drag & Drop 
Confirm the assigned Wave Data 
on “Score Window.” 

Select one of assigned wave data. Then, 
drag the file onto STM CH1/CH2 area 
on Piano Roll Window, and drop. 
Finally, Wave data was assigned into 
music data as StreamPCM. 

   
1 2 43 5
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4.2.4. Event List Window 
 

In “Event List Window”, contents read into “Score Window” are displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

No. Name Description 
1 [Ch1~16], [Stream PCM] and 

[All] part tabs 
By clicking each tab, a prat displayed on the “Event List Window” can be 
changed.  

2 Scroll buttons Part tab is scrolled left or right by pressing this button. Part tab that is not 
displayed can be displayed.  

3 Tick (Location) Displays a location of each event by using the unit of Tick.  
4 Ch (Channel) Displays a channel of each event.  
5 Type Displays the type of each event.  
6 Value1 “Control Change”…Displays a data value. 

“Pitch Bend”…Displays a pitch bend value. 
“Note”…Displays a note number. 
“Stream PCM”…Displays a WaveID.  

7 Value2 “Note”…Displays game time of note. 
“StreamPCM”…Displays gate time of Stream PCM.  

8 Value3 “Note”…Displays velocity of note. 
“StreamPCM”…Displays velocity of Stream PCM.  

1 2

3 4 5 6 7 8

Figure. 4-4 Event List Window 
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4.3. Voice List Window 
 

Display “Voice Map.” 
Click “Voice List” in “Application Window”, or select “Voice List” from “Window Menu” in “Menu Bar.” 
When SMF is loaded, applicable voices of Voice List are assigned as a MLD voice. 
 
 

4.3.1. Normal Voice List 
 
“Normal Voice List” is displayed by clicking “Normal Tab.” 
In “Normal Voice List”, voice names and voice types which correspond to program changes per bank are 
displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
【Note】 By “Import from Voice” button in tool bar, import of voice from Voice list to Voice Assign Map is 

possible, in addition, by “Export from Voice” button, export of voice from Voice Assign Map to Voice 
list is possible. 

 
【Note】 In normal voice list, voice names and voice types corresponding to program numbers of each Bank are 

displayed, and in drum voice list, voice names and voice types corresponding to note numbers of each 
program are displayed. 

 
【Note】 Each voice can be changed and be saved by Bank unit. For details about the save of voice list, see 

“4.15.3Save of Voice List.” 
 

No. Function Name Contents 
1 Normal tab Displays Normal Voices. 
2 Bank M Displays BankSelect MSB. 
3 Bank L Displays BankSelect LSB. 

In case of drum voice, it becomes “Pch#” display. 
4 Pch# Displays voice numbers. 

In case of drum voice, it becomes “Note#” display. 
5 Instrument Displays voice names. When voice name is double-clicked, Voice Edit window is 

opened. The background of voices that includes “AL parameters” is displayed with 
green. 

6 Type Displays operator that is used. 
F4: 4 Operators setting / F2: 2 Operators setting / P: PCM setting 

1 

2 
3 
4 

5 6

Figure. 4-5 Voice List Window (Normal Voice) 
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4.3.2. Drum Voice List 
 

“Drum Voice List” is displayed by clicking “Drum Tab.” 
In “Drum Voice List”, voice names and voice types which correspond to program changes per bank are 
displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

No. Function Name Contents 
1 Drum tab Displays Drum Voices. 
2 Bank M Displays BankSelect MSB. 
3 Pch# Displays voice numbers. 

In case of drum voice, it becomes “Note#” display. 
4 Note# Displays Note Numbers. 
5 Instrument Displays voice names. When voice name is double-clicked, Voice Edit window is 

opened. The background of voices that includes “AL parameters” is displayed with 
green. 

6 Type Displays operator that is used. 
F4: 4 operators setting / F2: 2 operators setting / P: PCM setting 

1

2 
3 
4 

5 6

Figure. 4-6 Voice List Window (Drum Voice) 
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4.3.2.1. Voice List Window (Copy & Paste Function) 
 

By right-clicking the voice name of Voice List Window, “Voice data Copy/Paste” function menu is 
displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.3.2.3.1. Copy & Paste 
 
 

1. At first, right-clicks the mouse on the voice, which you want to 
copy, on the voice list window. Popup menu is displayed, and then 
selects “Copy” here. 
 

2. Secondly, right-clicks the mouse on the voice name of voice, 
where you want to paste the copied voice. Popup menu is 
displayed, and then selects “Paste” here. For the details about 
voice paste to “Voice Assigned Map”, refer to “4.4.1Voice Assign 
Map (Copy & Paste Function).” 
 

3. Finally, the voice is pasted. 
 
 
 
 
 
 
【Note】 The copy/paste operation of voices can also be made by using “Copy” or “Paste” on the “Edit” menu of 

the application, or by using Toolbar of the application. 
 
 
 

No. Function Name Contents 
1 Copy Voices can be copied. 
2 Paste Voice can be pasted. 

1 
2

Figure. 4-7 Voice List Window (Copy & Paste Function) 
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4.3.2.2. Voice List Window (Right-Click Menu) 
 

By right-clicking the “Bank M” section, a pop-up menu is displayed.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4.3.2.3. Loading Voice List 
 
 
 
4.3.2.3.2. Loading of All Voice 
 

Saved voice file can be read. 
Select “Open Voice File” from “File” menu of the menu-bar 
on the “Application Window.” “Open” dialog box is displayed, 
and then, selects a file name and click “Open” button to read 
the voice file. 

 
 
 
 
 
4.3.2.3.3. Loading by Bank Unit (Normal/Drum Voice Bank) 
 

Saved voice file can be read in Normal Voice List and Drum Voice List. 
 

Bank voice files saved with MA-3 Authoring Tool or MA-5 Authoring Tool can be read for the Normal 
voice list or the Drum voice list. 
Right-clicks on the Bank MSB field of Voice List. Selects “Import from Bank Voice” from the “Popup 
Window.” “Open” dialog box is displayed. Selects a file name, and then click “Open” button to read the 
voice file. 

No. Function Name Contents 
1 Import from Bank Voice… Saves voice by Bank unit. 

For details, see “4.3.2.4Saving Voice List.”  
2 Export to Bank Voice Loads voice by Bank unit. 

For detail, see “4.3.2.3Loading Voice List.”  

Figure. 4-9 Loading of All Voices 

Figure. 4-8 Voice List Window (Right-Click Menu) 

1
2 
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4.3.2.4. Saving Voice List 
 
 
 
4.3.2.3.4. Saving All Voices 
 

Select “Save Voice File” from “File” menu of the menu-bar 
on the “Application window.” “Save As” dialog box is 
displayed. Enter the file name in “File name” (the extension 
are “*.vm3(MA-3)”, “*.vm5(MA-5)”), and then click “Save” 
button to save the data. 

 
 
 
 
 
 
 
4.3.2.3.5. Loading by Bank Unit (Normal/Drum Voice Bank) 
 

Voices that is registered in the Normal or Drum 
voice list can be saved by bank unit. 
Right-clicks on the Bank MSB field of Voice List. Select “Export to Bank Voice” from the “Popup 
window.” “Save As” dialog box is displayed. Enters the file name into the “File name” (extension are 
“.vm3 (MA-3)”, “.vm5 (MA-5)”) and click “Save” button to save the data. 

Figure. 4-10 Saving All Voice 
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4.4. Voice Assign Map 
 

Display voices which are used by each channel per channels.  
Voices up to 128 including all channels can be displayed. (Data which uses more than 128 voices cannot be 
read.) 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Function name Contents 
1 ALL Displays all used voices. 
2 Ch1~Ch16 Displays the used voices per channels. 
3 Vo. Displays the number of used voices. 
4 C (Change Flag) When comparing the bank number of same voice list and voice of same voice number, 

and if the result is different, a blue circle is displayed. 
5 Bank M (Bank Select MSB) Displays BankSelect MSB. 
6 Bank L (Bank Select LSB) Displays BankSelect LSB. 
7 Pch Displays program change number. 
8 Note Displays note number. 
9 Name Displays voice name. When a voice name is double-clicked, Voice Edit window will be 

opened. (Voice Edit window of built-in ROM voices cannot be opened.) 
10 Type Displays voice type to use. 

F4: 4 operators setting, F2: 2 operators setting, P: PCM setting. 
11 AL  AL voice use in an applicable voice is specified. 
12 WaveID When used voice PCM and RAM voice is used, its WaveID is displayed. 

When using Drum voice “RM” of ROM, “RM0~6” is displayed.  
13 TS[B] (Total Size) RAM size for used voice is displayed. The unit is “Byte.” 

For details about RAM size, see “3.6.1About RAM Size.”  

1 2

3 4 5 6 7 8 9 10 11 12

Figure. 4-11 Voice Assign Map Window 

13
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4.4.1. Voice Assign Map (Copy & Paste Function) 
 

By right-clicking the voice name of Voice Assign Map, “Voice data Copy/Paste” function menu is 
displayed. 

 
【Note】 For details of Color Data Copy/Paste function, see “4.3.2.3.1 Copy & Paste.” 
【Note】 Preset voice (*1) assigned on Voice Assign Map can be edited. 

Edited voice data can be copied and pasted onto the Voice List as a user voice (*2).  
 

Normal voice Bank MSB=124, LSB=0 (*1) Preset voice 
Drum voice Bank MSB=125, LSB=0, Pch#=0,1 

Normal voice Bank MSB=124, LSB=1 to 9 (*2) User voice 
Drum voice Bank MSB=125, LSB=0, Pch#=2 to 9 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

No. Function Name Contents 
1 Paste Voice List Displays the contents of Voice List. For details, see the following figure.  
2 Copy Voices can be copied. 
3 Paste Voice can be pasted. 

The voice assignment method to MLD can also select and assign a voice from “Paste Voice List” of 
Voice Assign Map besides copy & paste of Voice List to Voice Assign Map. 

It is possible to change a voice by choosing Paste Voice List, and following and choosing a voice from 
the menu displayed by carrying out the right click of the voice name changing.  
 

Voice Copy/Paste Function 

1 
2 
3 

Figure. 4-12 Voice Assign Map (Copy & Paste Function) 
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4.4.2. Voice Assign Map (Right-Click Menu) 

 
By right-clicking on a status such as “Bank M”, the Voice Assign Map right-click menu will appear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
【Note】 The voice data of the same bank and voice number as a preset voice is not exported to the Voice List by 

[Export to Voice List]. For registering such voice data into the Voice List, paste it into the user voice 
bank area with Copy/Paste function. For the detail, please refer to “4.4.1 Voice Assign Map (Copy & 
Paste Function).” 

 
 

No. Function name Contents 
1 Import from Voice List Voice, which has the same voice number and same bank number in the Voice List, is 

imported into Voice Assign Map. 
In addition, the same operation can be performed same operation with “Import from 
Voice List” in a tool bar. For details, see “4.15.2.1Assignment of Voice Data in Block.” 

2 Export to Voice List Voice, which has the same voice number and the same bank number in the Voice List, is 
exported from Voice Assign Map. 
In addition, the same operation can be performed with “Export to Voice List” in a tool 
bar. For details, see “4.15.2.1Assignment of Voice Data in Block.” 

3 Undo Makes the last copy operation for voice invalid and returns it into the previous state. 
4 Redo Repeats the same process as the last performed process. 

1 
2 
3 
4 

Figure. 4-13 Voice Assign Map (Right Click Menu) 
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4.5. StreamPCM Assign Map 
 

Stream PCM is assignable. 
Stream PCM can be registered the maximum of 32 waves, and can be simultaneously generated to two 
sound.  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 
 
 
4.5.1. Details about Note to which a StreamPCM can be assigned 
 

In order to register a Stream PCM event into SMF, it is necessary to set up by Bank Select, Program 
Change, or Note number beforehand, in other words, assigns by Stream PCM Edit Window of Piano Roll. 

The bank selection of the note which can be used as a Stream PCM, a program change (an arbitrary value 
needs to be program changed for decision of a bank selection), and the note number are as follows. 

 
Bank MSB Note number Definition 

0 WaveID:1 
1 WaveID:2 
: WaveID:X 

12 

Stream PCM

WaveID:13 
13 
14 
: 

91 

Drum Channel 

92 WaveID:14 
93 WaveID:15 
: WaveID:X 

125 

110 

Stream PCM

WaveID:17 
 
【Note】 For details, see “Contents Authoring Guideline.” 

No. Function Name Contents 
1 WaveID Displays wave ID. Corresponds to Note number. Up to 32 waves can be registered.  
2 Wave Type Displays wave type. 
3 Fs Displays the frequency of wave. 
4 Note Displays note numbers. (0 to 12 and 92 to 110) 
5 Wave Type Displays wave type. 
6 Pan Displays pan of Wave. 
7 Size Displays the size of the read wave data. 
8 S/M (Stereo/Mono)  The read wave data indicates whether it is stereo wave data and whether it is monophonic 

wave data. 

61 2 3 4 5

Figure. 4-14 StreamPCM Assign Map 

7 8 
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4.5.2. Details about Sound File which can be registered as StreamPCM 
 

  In MA-5 Authoring Tool, it is possible to convert a sound file as an encoding-processed (compressed) 
StreamPCM and to register it to MLD, so that a channel sequence and a sound file (AIFF/WAVE) can be 
played synchronously on MLD. Stream PCM can be registered up to 32 kinds and can generate up to 2 
sounds simultaneously. 
 

 
 

Read Sound File Stream PCM 
Bit Rate Sampling Frequency  Bit Rate Sampling Frequency  

16-bit 4KHz ~24KHｚ AIFF/WAVE 
Monophonic 4-bit ADPCM 

16-bit 4KHz ~12KHｚ AIFF/WAVE 
Stereo 4-bit ADPCM 

 
 

 
 
 

4.5.3. StreamPCM Assign Map (New/Delete Function) 
 

By right-clicking the Stream PCM Assign Map window, “New/Delete” menu is displayed. In addition, it 
makes possible to perform the registration and delete of sound files. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
If the right click of the inside of a “Stream PCM Assign Map Window” is carried out, a New/Delete menu is 
displayed and registration of a sound file and deletion can be performed. 

 
 
【Note】 Refer to “4.5.2Details about Sound File which can be registered as StreamPCM”, for details about Fs 

of the file which can be read as a Stream PCM, and the encoding system which can be chosen. 
 
【Note】 Stereo Sound can be registered to one wave ID. (Stereo Lch/Rch is considered as one wave and it is 

counted as one). 
 

No. Function Name Contents 
1 New Opens a new WAVE data. 
2 Delete Deletes an opened Wave data. 

Figure. 4-15 StreamPCM Assign Map (New/Delete) 

1 
2 
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4.5.4. StreamPCM Wave Panpot 
 

By double-clicking the pan-display column, “Stream PCM Wave Panpot” dialog opens and the panpot can 
be set. 

 
 
 
 

 
 

 
 

 
 
 
 
 
 

When a section of Pan Display is double-clicked, “Stereo PCM Wave Panpot” is opened; 
In addition, pan can be set up. 
When a sound file is loaded, Panpot will be set up automatically according to the kind of sound file. 
 

・ Mono sound file : Panpot=64 
・ Stereo sound file : PanOff (Stereo Playback) 

 
 
【Note】  For “Stream PCM Wave Panpot Clear” and “Stream PCM Wave Panpot PanOFF”, refer to 

“Contents Authoring Guideline For MA-5 Authoring Tool.” 
 
 
 

4.5.5. StreamPCM Assign Map (Right-Click Menu) 
 

By right-clicking on the status such as “WaveID” or “Fs”, a pop-up menu is displayed. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

No. Function name Contents 
1 Import from Stream PCM File Waveform data can be read from Stream PCM File that has been saved in 

Export to Stream PCM File. 
2 Export to Stream PCM File All waveform data registered in Stream PCM Assign Map can be saved in 

StreamPCM File. (extension is “*.sm5”) 

Figure. 4-16 Stream PCM Wave Panpot 

1 
2 

Figure. 4-17 StreamPCM Assign Map (Right-click Menu) 
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4.6. Mixer 
 

  The playback balance of each channel can be kept. (The balance cannot be changed during a playback of 
data.) 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

4.7. Event Density 
 

Converts the event density to the MIDI byte counts in the read music and displays it. 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

No. Function name Contents 
1 Bank MSB (Bank Select MSB) Displays BankSelect MSB. 
2 Bank LSB (Bank Select LSB) Displays BankSelect LSB. 
3 Prg (Program) Displays Program Change Number. 
4 Mute Mutes a relevant channel. This is not reflected on the music data (MLD). 
5 Solo Plays a relevant channel with solo. This is not reflected on the music data (MLD).
6 Vol Displays a volume value. 

No. Function name Contents 
1 Event Density [byte/s] Displays event density. The unit time used as criteria when converting an event 

density can be set up by preference. 
2 Measure/Time [Sec] Displays time. 

•·In case of SMF import    : Measure (beat unit) is displayed. 
• In case of MLD Open    : Time “sec” is displayed. 

1 
2 
3 
4 
5 
6 

Figure. 4-18 Mixer Window 

1 

2 

Figure. 4-19 Event Density 
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4.8. Velocity Change 
 

Velocity of Note event in read music can be changed. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

No. Function name Contents 
1 Channel Designates the channel to change its velocity. 

1,2,3,4,5,6,7,8,9,10,11,12,13,14,15,16 channel, STM (StreamPCM), and ALL (All note 
event) can be designated. 

2 Rate [%] Designates the change rate of velocity value 50 ~ 200%. 
3 Curve Designates the curve which changes a velocity. There are two kinds of curves 

“20logto40log” and “40logto20log.” 

1
2

3

Figure. 4-20 Velocity Change Dialog 
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4.9. MLD Information 
 

Information can be input / edited. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

No. Function name Contents 
1 Distribute Sets up allow/prohibit of re-distribution. 
2 MLD Version Displays the version information. 
3 Code Type Sets up the code type. 

Only “UTF-8” can be selected. 
4 Song Title You can enter the song name here. The available character numbers are up to 50 by half size 

character. 
5 Date Created You can enter the creation date and time here. Be sure to type 8 half size characters here. 

E.g. January/15/2004  20040115 
6 Copyright© Copyright can be input. The number of character which can be input is up to 255 in half-size.
7 Copyright Management 

Information 
Copyright management information can be input. The number of character which can be 
input is up to 255 in half-size. 

8 Data Management 
Information 

Data management information can be input. The number of character which can be input is 
up to 255 in half-size. In addition, name of lyric writer can be input here. 

1 2 3

4 

5 

6 

7 

8 

Figure. 4-21 Edit Information 
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4.10. File Access Log 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
Log is displayed when operation related to the file is performed. 
The performed operation and path of file are displayed. 
The contents of display do not disappear until application ends. 

 
 
 

4.11. Transpose 
 

The note number of the note event in the sound data can be shifted in the range of “+12” – “-12.” 
 
 
 
 
 
 
 
 
 
 
 
 

 
【Note】 Setting of Transpose is reflected to SMAF file. 
 

 

No. Function name Contents 
1 Channel Selects the channel to shift the note number. 

When “ALL” is selected, the note number of all channels is shifted.  
[Note]  
- This setting is valid only for normal channel. 
- The channel having no note event and HV channel are not selectable.
- The note number of drum channel doesn’t shift. 

2 Transpose Sets Key control. 
The range from “+12” to “-12” is selectable. 

Figure. 4-22 File Access Log 

1

2
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4.12. Preference 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Function name Contents 
Switches FM mode. 
When music data is read in Authoring Tool, FM mode can not be switched. 
So, be sure to switch to FM mode after close music data. 
FM16 Mode 
This is a mode in which can use 2-operator voice, 4-operator voice, and PCM voice. 
FM32 Mode 
This is a mode in which can use 2-oerator voice and PCM voice. 
ALL64 Mode 
This is a mode which can use 2-Operator voices and PCM voices. 
(Both AL parameter and StreamPCM can not be used). 

1 Contents Mode 

For details about the maximum number of voices that can be generated simultaneously, 
see “1About MA-5 Authoring Tool.” 

2 Output Format Displays an output format. 
3 Emulator Playback Frequency Playback frequency of emulator can be set up. 

Either of 48kHz (Default), 44.1kHz, 32kHz, or 22.05kHz can be selected. 
4 Event Dens. Width The unit time used as the reference at converting event density can be set up. 

0. 1 Sec, 0.2 Sec, 0.5 Sec, 1.0 Sec, 1.5 Sec, or 2.0 Sec can be chosen. 
(Density unit is Byte/Sec=Density/Width.) 

5 Pch Origin Whether program change number starts from “0” or from “1” can be selected by selecting 
Pch Origin. 

6 Note Origin It can set to display Note of 440Hz as A3 or A4. 
The Note display of EventList and PianoRoll change, but the tone of the voice to 
generate does not change. 

7 Default Directory It can be set as the default directory at the time reading various files by clicking the right 
side button and choosing arbitrary folders. 

 
 

1 
2 

4 

5 

6 

7 

Figure. 4-23 Preference Window 

3 
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4.13. DVA Checker 
 

This is a window to check the maximum simultaneous pronunciation numbers. 
When an error occurred in the maximum simultaneous pronunciation number, it is used to pinpoint the error 
parts.  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No. Function name Contents 

Check over the Max voice 
By clicking the Check button, the position of which it exceeded the number of 
maximum simultaneous pronunciation in each mode (FM32, FM16, ALL64) and 
its pronunciation number are checked. The value of “Time”, “FM” and “PCM” are 
displayed when the result is “Over.” 
Check the Max Voice Number of Sequence 

1 Mode 

By clicking the Check button, the position of the maximum simultaneous 
pronunciation number in data and the number of pronunciation are checked. 
The value of “Time”, “FM” and “PCM” are surely displayed, it is not concerned 
with Result. 

2 Output file By placing a check in a box, time of which it exceeded the number of maximum 
simultaneous pronunciation in each mode (FM32, FM16, ALL64) and its 
pronunciation number can be saved by text-file format. (DVAChecker_result.txt) 
The text file is saved in the folder which is installed in MA-5 Authoring Tool. 

3 Result Displays the result which checked the simultaneous pronunciation number. If it is 
not over the number of maximum simultaneous pronunciation in each mode, “O.K.” 
will be displayed. If it is over, “Over” will be displayed. And if the result is “Over”, 
open the above text file and confirm the details, please. 

4 Time Displays the object time in “ms” unit. 
5 FM Displays the number of simultaneous pronunciation of FM voice. 
6 PCM Displays the number of simultaneous pronunciation of PCM voice. 

1 
2 
3 4

5
6

Figure. 4-24 DVA Checker 
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4.14. about Authoring Tool 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
【Note】 Refer to “3.3.6Help Menu” to open this window. 

Figure. 4-25 about Authoring Tool 
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4.15. Voice Edit 
 
 
 
4.15.1. About Voice Bank 
 

This is a list of voice banks which can be used by MLD. Assigned area differs depending on a bank 
specified in SMF. Voice edit possible or impossible, voice, etc. differs depending on an assigned bank. 
 

 
 
 

Normal Voice 
 
 

Kinds of voice Preset User 
Bank MSB 124 124 
Bank LSB 0 1 to 9 
Program Change 0 to 127 0 to 127 
Voice Edit Impossible Possible 

 
 
 
 

Drum Voice 
 
 

Kinds of voice Preset Preset User 
Bank MSB 125 125 125 
Bank LSB 0 1 2 to 9 
Program Change 13 to 91 13 to 91 13 to 91 
Voice Edit Impossible Impossible Possible 
Others Mixed with PCM voice Only FM － 

 
 
【Note】 For details, see “Contents Authoring Guideline.” 
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4.15.2. Assignment of Voice Data 
 
 
 
4.15.2.1. Assignment of Voice Data in Block 
 

The voices of Voice List and Voice Assign Map are imported or exported in block. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Function name Contents 
Import From Voice List This is a Right-click menu of Voice Assign Map. 

Voices in the same Bank position are imported from Voice List to Voice 
Assign Map in block. 
It is effective when loading a Voice file.  

Export to Voice List This is a Right-click menu of Voice Assign Map. 
Voice Assign Map data is exported as voices whose Bank position is the 
same in VoiceList.  

 

Import from Voice List 

Export to Voice List 
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4.15.2.2. Individual Assignment of Voice Data 
 

Copy & Paste is performed between Voice List and Voice Assign Map, and voice is assigned. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
【Note】 It is possible to assign voices from “Paste Voice List” of “Voice Assign Map.” For details, refer to “.” 

 
 
 
 
 
4.15.3. Save of Voice List 
 
 
 
 
4.15.3.1. Saving All Voices 
 

  Select “Save MA3/5 Voice File” from “File” menu of the menu-bar on Application Window. “Save As” 
dialog box is displayed. Enter the file name in “File name” (extension is “*.vm3/*.vm5”) and click “Save” 
button to save the data. 
 
 

 
 
 
4.15.3.2. Saving by Bank Unit 
 

  Right-click BankMSB column of VoiceList. Select “Export 
to Bank Voice” from the popup window. “Save As” dialog box 
is displayed. Enter the file name in “File name” (extension is 
“.vm3”) and click “Save” button to save the data. 
 
 

Copy & Paste 

Copy & Paste 
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4.15.4. Loading Voice List 
 
 
 
4.15.4.1. Loading All Voices 
 

  Select “Open MA3/5 Voice File” from “File” menu of the menu-bar of Application Window. “Open” 
dialog box is displayed. Select the name of extension voice list file to read and click “Open” to open the 
voice list file. 
 
 

 
 
 
4.15.4.2. Loading by Bank Unit 
 

Right-click BankMSB column of VoiceList. Select “Import 
from Bank Voice” from the popup window. Dialog box is 
displayed. Select the name of extension voice list file to 
read and click “Open” button to read the voice list file. 
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4.16. FM Voice Edit Parameter 
 

By double clicking the user voice name, Voice Edit window is displayed. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No. 1- 12 
 
No. Function name Contents 

1 Bank MSB Displays Bank MSB in which the voices being edited exist. It cannot be changed here. 
2 Bank LSB Displays Bank LSB in which the voices being edited exist. 
3 Pch Displays/Changes the program change for the voices being edited. 
4 LFO Sets LFO frequency that is used for each voice. 

LFO= 0 : 1.8 Hz, LFO= 1 : 4.0 Hz, LFO= 2 : 5.9 Hz, LFO= 3 : 7.0 Hz 
5 Panpot Sets right-left balance for each channel. (0…15…31) 

The smaller value, the further it pans to the left, or the larger value, the further it pans to 
the right. 

6 PE Place a check in this box to disable the pan setting of the control change and to enable 
the value of panpot of the voices. 

7 DrumKey Parameter that functions only at edition of the drum voice. It changes the key which the 
voice being edited actually generates. 

8 Operator 1, 2, 3, 4 
 
 
 

Changes Operator. The display changes between 1 to 2 and 1 to 4 in accordance with the 
setting of the algorithm. Right-click on the tab of Operator1 to 4 to display Copy/Paste 
menu with which the Operator can be copied. 

9 Voice No. Displays the voice number being edited with Voice Assign Map. 
10 Before the Change Press this switch to listen to the voices before they are edited. Press this switch again to 

restore the voices being edited. 
11 Voice Name Sets the voice name being edited. 

1 10 

11 

9

12-13 

14-31 

32-41 

2 
3 
4 
5 

6 
7 
8 

Figure. 4-26 FM Voice Parameter 
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No.12-13 
 
 
 
 
 
 
 
 
 
No. Function name Contents 

12 ALG (Algorithm) 
 
 
 
 
 
 

Sets algorithm. 2 Operator or 4 Operator is set in accordance with the type of algorithm. 
 
 
 
 
 
 
 
 
 
 
 
 
 

13 Op OFF [Operator OFF] The output of each operator can be turned OFF by selecting the button of 1 to 4. 
 
 
No.14-31 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No. Function name Contents 

14 MULTI 
 
 
 
 

Designates a multiplier for the frequency. 
 

MULTI 0 1 2 3 4 5 6 7 8 9 10,11 12,13 14,15
Multiplier 1/2 1 2 3 4 5 6 7 8 9 10 12 15  

15 DT (Detune) Designates Detune. Detune shifts the pitch delicately to cause the feeling of chorus. 
DT=1 to 3 shifts the pitch upwards. Difference width becomes large in the order of 1, 2, and 3. 
DT=5 to 7 shifts the pitch upwards. Difference width becomes large in the order of 5, 6, and 7. 
DT= 0 and 4, it is standard pitch. 
The frequency of Detune is affected by the setting of MULTI. When MULTI= 2 times, the 
values of Detune are doubled. 

16 AR (Attack Rate) Attack Rate is the time from the starting of tone generation (-96 dB) to the time of maximum 
volume (0 dB). 

17 DR (Decay Rate) Decay Rate is the decay time from the moment the maximum volume (0 dB) to the moment 
Sustain Level (SL). 

18 SR (Sustain Rate) Sustain Rate designates the rate of decay from the moment a Sustain Level is attained. Unlike 
other rate setting, setting this to “0” causes continuation of the Sustain Level. 

12 

13

Algorithm 1  Algorithm 2 

Algorithm 4 Algorithm 3 

In FM32 mode, when algorithm of 2op is not selected, it does not generate 
normally. Please set 0 or 1 to ALG. 

14 
15 
16 
17 
18 
19 
20 
21 

27-31

22 
23 
24 
25 
26 
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No. Function name Contents 
19 RR (Release Rate) Release Rate is the time from key off to the moment the silent state (-96 db) is attained. When a 

check is placed in the check box of SUS, the setting is ignored. 
20 SL (Sustain Level) The Sustain Level is the one at which Decay Rate changes to Release Rate for decaying tone, or 

the level at which volume of a continuous tone is sustained. 
21 TL (Total Level) Sets the level of envelope. 
22 KSL  

(Designation of Level 
Scaling) 

For natural instruments, the volume generally decreases and the interval becomes higher. The 
scaling of level simulates this phenomenon. KSL sets the amount of decay per octave. 
KSL= 0 :  0,  KSL= 1 :  3.0dB / oct 
KSL= 2 :  1.5dB / oct,  KSL= 3 :  6.0dB / oct 

23 DAM  
(Depth of Amplitude 
Modulation) 

Sets the depth of amplitude modulation (AM). 
DAM= 0 : 1.3 dB, DAM= 1 : 2.8 dB 
DAM= 2 : 5.8 dB, DAM= 3 : 11.8 dB  

24 DVB  
(Depth of Vibrato 
Modulation) 

DVB= 0 : 3.4 cents, DVB= 1 : 6.7 cents 
DVB= 2 : 13.5 cents, DVB= 3 : 26.8 cents  

25 FB  
(Amount of Feedback) 

This function enables only Modulator side Operator. It designates the degree of feedback 
modulation. 

Setting value 0 1 2 3 4 5 6 7 
Degree of modulation 0 π /16 π /8 π /4 π /2 π 2π 4π  

26 WS  
(Waveform election) 

Designates waveform of each Operator that is used for FM operation. The waveform that is 
used can be selected from 29 types. 

27 XOF 
(Ignore KeyOff) 

Sets whether to ignore KeyOff or not. Place a check in the check box to ignore KeyOff. KeyOff 
does not cause the change of state. 

28 SUS (Sustain) Sets whether to allow the rate change after KeyOff is allowed or not. When check is placed in 
the check box and Hold 1 (damper) information of MIDI message is received, SR continues 
after KeyOff. 
 
 
 

29 KSR 
(Rate scaling) 

Sets rate key scale ON/OFF. Place a check in the check box to enable setting of KSL. 
Key scale ON/OFF of the rate can be set up by checking this box. By the natural musical 
instrument, the standup and falling of sound become early as a pitch becomes high in general. 
The key scale of the rate simulates this phenomenon. 

30 EAM   
(AM modulation) 

Sets amplitude modulation ON/OFF. Place a check in the check box to enable setting of DAM. 

31 EVB  
(Vibrato modulation) 

Sets vibrato modulation ON/OFF. Place a check in the check box to enable setting of DVB. 
 
 
 

 

For making effective the hold1 (damper) of MIDI message, be sure to set SUS to ON. 

Be sure to set EVB to ON to enable modulation of MIDI message. 
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4.16.1. List of FM Fundamental Waveform 
 
 

 
 

FM Fundamental Wave Form 
 
No. 32-36 Keyboard 

The voice under editing can be monitored by clicking the keyboard. 
 
Display of normal voice being edited 
In the case of normal voice, it generates higher musical interval as going the right side of the keyboard, and 
lower musical interval as going toward the left side. 

 
 
 
 
 
 
 
 
 
 

No. Function name Contents 
32 DrumKey Assign It is not used when editing normal voice. (It is valid only when editing drum voice) 
33 All Sound Off Sound generation of all the designated channels stops. 
34 MV (Master Volume) Master volume value when monitoring by the keyboard can be changed. 
35 Velocity (Velocity) Velocity value when monitoring by the keyboard can be changed. 
36 Scrolling button By pushing this button, the displayable range of keyboard can be changed. 

▪ Click of right side button displays higher interval. 
▪ Click of left side button displays lower interval. 

 

34

36 

32 

36 

35 
33
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No. 37-41 Keyboard 
 

Display of drum voice edited 
In the case of drum voice, it generates only when Note No. under editing is clicked. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Function name Contents 
37 DrumKey Assign By pushing this switch, it can generate the drum voice in higher musical interval as going 

toward the right side of keyboard, and in lower musical interval as going toward the left 
side.  
A generated key is automatically set to DrumKey. 
(DrumKey Assign shown in the following figure means the switch is being pushed.) 
 
 
 
 
 
All keys can be generated by pushing the DrumKey Assign switch. 

38 All Sound Off Sound generation of all the designated channels stops. 
39 MV (Master Volume) Master volume value when monitoring by the keyboard can be changed. 
40 Velocity (Velocity) Velocity value when monitoring by the keyboard can be changed. 
41 Key Displays only the note number under editing. 

 

DrumKey Assign

39

40 37 

41 

38 
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4.17. PCM Voice Edit Parameter 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No.1-7 
 
 
 
 
 
 
 
 
 
No. Function name Contents 

1 Bank MSB Displays BankSelect MSB in which the voices being edited exist. It cannot be changed 
here. 

2 Bank LSB Displays BankSelect LSB in which the voices being edited exist. 
3 Pch Displays and changes program change for the voices being edited. 
4 LFO Sets LFO frequency that is used for each voice. 

LFO= 0 : 1.8 Hz, LFO= 1 : 4.0 Hz 
LFO= 2 : 5.9 Hz, LFO= 3 : 7.0 Hz 

5 Panpot Sets right-left balance for each channel. (0…15…31) 
The smaller value, the further it pans to the left, or the larger value, the further it pans 
to the right. 

6 Voice No. Displays the voice number being edited with Voice Assign Map. 
7 Voice Name Sets the voice name being edited. 
 

1 
2 
3 

4 
5 

6

7

8 

18
19

20 

21 
22 

23-30 

1-7 

9 
10 
11 
12 
13 
14 
15 
16 

17 

Figure. 4-27 PCM Voice Edit Parameter 
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No.8-23 
 
 
No. Function name Contents 

Load Wave File Monoral sound file (AIFF, WAVE) of up to 48kHz with 8bitPCM or 16bitPCM can be 
loaded. 16bitPCM data is cnverted into 4bitADPCM data. 
The loaded wavefile is assigned to NoteNo.60 (C key). 
E.g. 
When a 24000Hz sound file is read 
Fs become lower when lower key is played, and Fs become higher when higher key is 
played, when taking C key of NoteNo.60 (24000Hz) as a center. When a waveform is 
read, “Load Wave File” button changes to “Detach Wave File” button. 

8 

Detach Wave File Press this switch to delete the waveform that has been read with “Load Wave File.” 
 
 
 
 
 
 
 
 
 
 
 
 

9 AR (Attack Rate) Attack Rate is the time from the starting of tone generation (-48dB) to the time of 
maximum volume (0 dB). 

10 DR (Decay Rate) Decay Rate is the decay time from the moment the maximum volume (0 dB) to the 
moment Sustain Level (SL). 

11 SR (Sustain Rate) Sustain Rate designates the rate of decay from the moment a Sustain Level is attained. 
Unlike other rate setting, setting this to “0” causes continuation of the Sustain Level. 

12 RR (Release Rate) Release Rate is the time from key off to the moment the silent state (-96 db) is attained. 
When a check is placed in the check box of SUS, the setting is ignored. 

13 SL (Sustain Level) The Sustain Level is the one at which Decay Rate changes to Release Rate for decaying 
tone, or the level at which volume of a continuous tone is sustained. 

14 TL (Total Level) Sets the level of envelope. 
15 DAM  

(Depth of AM 
modulation) 

Sets the depth of amplitude modulation (AM). 
DAM= 0 : 1.3 dB, DAM= 1 : 2.8 dB 
DAM= 2 : 5.8 dB, DAM= 3 : 11.8 dB  

16 DVB (Depth of vibrato 
modulation) 

DVB= 0 : 3.4 cents, DVB= 1 : 6.7 cents 
DVB= 2 : 13.5 cents, DVB= 3 : 26.8 cents 

XOF (Ignore KeyOff) Sets whether to ignore KeyOff or not. Place a check in the check box to ignore KeyOff. 
KeyOff does not cause the change of state. 

SUS (Sustain) Sets whether to allow the rate change after KeyOff or not. When check is placed in the 
check box and Hold 1 (damper) information of MIDI message is received, SR continues 
after KeyOff. 
 
 
 

EAM (Amplitude 
modulation On/Off) 

Sets amplitude modulation ON/OFF. Place a check in the check box to enable setting of 
DAM. 

EVB (Vibrato 
modulation On/Off) 

Sets vibrato modulation ON/OFF. Place a check in the check box to enable setting of 
DVB. 
 
 
 
 

PE (Pan-enable) Place a check in the check box to disable pan setting of the control change and to enable 
the value of panpot of voices. 

17 

RM (Designation of 
ROM/RAM) 

Selects ROM or RAM for waveforms that are used. When ROM is designated, a 
waveform can be selected from seven waveform list in the ROM at Wave ID. When 
RAM is designated, arbitrary waveform can be designated from the load wave file. 

18 Wave ID For MA-5, multiple PCM waveforms can be read and stored. The management number 
can be displayed and selected.  

When a waveform is read, 
“Load Wave File” button 
changes to “Detach Wave 
File” button. 

Be sure to set EVB to on to enable modulation of MIDI message. 

Sets vibrato modulation ON/OFF. Place a check in the check box to enable 
setting of DVB. 
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No. Function name Contents 
19 Fs Displays the frequencies of waveforms that have been read. 

On MA-5 Authoring Tool, displays the frequency when flipping NoteNo.60 (C key). 
Changing the value changes the pitch. 

20 Wave Name Displays the names of waveforms that have been read. 
 
 
 
 

21 LP  Designates a loop point for loop reproduction. 
In addition, a peak factor at the following point was displayed.  
4bits ADPCM :Loop Point 
8 bits PCM :Loop Point + 1  

22 EP  Designates reproduction end point and loop reproduction loop End Point. 
In addition, a peak factor at the following points was displayed. 
4 bits ADPCM  :End Point -1 
8 bits PCM           :End Loop Point 
 
 
 

 
 
No.23 to 30 
 

The voice under editing can be monitored by clicking the keyboard. 
 
Display of normal voice being edited 
In the case of normal voice, it generates higher musical interval as going toward the right side of keyboard, 
and lower musical interval as going toward the left side. 

 
 
 
 
 
 
 
 
 
No. Function name Contents 
23 Scrolling button By pushing this button, the displayable range of keyboard can be changed. 

▪ Click of right side button displays higher interval. 
▪ Click of left side button displays lower interval. 

24 All Sound Off Sound generation of all the designated channels stops. 
25 MV (Master Volume) Master volume value when monitoring by the keyboard can be changed. 
26 Velocity (Velocity) Velocity value when monitoring by the keyboard can be changed. 
 

It does not pronounce, if the value is “0”. 

Wave Name is not displayed on Wave ID field immediately after attaching 
Wave Name. Be sure to re-open Voice Edit to display it. 

23 23 

25

26 
24 
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Display of drum voice being edited 
In the case of drum voice, it generates only when the Note number which is being edited is clicked. 

 
 
 
 
 
 
 
 
 
 
 
No. Function name Contents 
27 All Sound Off Sound generation of all the designated channels stops.  
28 MV (Master Volume) Master volume value when monitoring by the keyboard can be changed. 
29 Velocity (Velocity) Velocity value when monitoring by the keyboard can be changed. 
30 Key Only the Note number being edited can be displayed. 
 

28 

29 

30 

27 
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4.17.1. LP/EP Automatic Control Function 

 
At the time of displaying a Voice Edit of existing PCM voice, if there are any uncorrected values which are 
set on it, the following confirmation messages will be displayed.  
“Automatically operated- Loop and/or End Point adjusted according to PCM mode.” 
Then, the uncorrected values are rounded to a correct value automatically. 
 

 

Example of rounding the sampling number “2000”, 

 

<with 4bit ADPCM> 

In case of the OneShot(LoopPoint=EndPoint) 

In case of (LoopPoint ≥ Sample number) or (EndPoint ≥ Sample number) 

  LoopPoint = EndPoint = Sample - 1 

  ex) LP=2000/EP=2000 → LP=1999/EP=1999 

     LP=2000/EP=2001 → LP=1999/EP=1999 

In the case in which only LoopPoint is outside of the range. 

  LoopPoint = EndPoint 

ex) LP=2001/EP=1500 → LP=1500/EP=1500 

In the case in which only EndPoint is outside of the range. 

  EndPoint = Sample - 1 

  ex) LP=1500/EP=2001 → LP=1500/EP=2000 

 

<with 8bits PCM> 

In case of the OneShot(LoopPoint=EndPoint) 

In case of (LoopPoint≥Sample -1) or (EndPoint≥Sample -1) 

  LoopPoint = EndPoint = Sample -2 

  ex) LP=2000/EP=2000 → LP=1998/EP=1998 

In the case in which only LoopPoint is outside of the range. 

  LoopPoint = EndPoint 

  ex) LP=2001/EP=1500 → LP=1500/EP=1500 

In the case in which only EndPoint is outside of the range. 

  EndPoint = Sample - 1 

  ex) LP=1500/EP=2001 → LP=1500/EP=1999 
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4.18. AL Voice Edit Parameter 
 

Double-click user voice name on the voice list window to display voice edit window, where double-clicking 
on AL Voice Edit tab can set AL voice parameter. 
To open voice AL voice edit on the voice assign map, the channel in which voices for which AL voice is to be 
used are inputted must be designated as AL channel. By placing a check in “AL” field of score window can 
be set as AL voice. Voices of AL channel are generated as monaural. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
No.1 to 10 
 

No. Name Description 
1 AL Voice Parameter Switches to AL Voice Parameter. Only when a voice which is assigned as AL 

voice was selected, this tab will be appeared. 
2 Bank MSB Displays bank MSB in which the voices being edited exist.  
3 Bank LSB Displays bank LSB in which the voices being edited exist.  
4 Pch (Program Change) Displays program change for the voices being edited.  
5 Voice No (Voice Number) Displays the voice number being edited with Voice Assign Map.  

2 
3 
4 

1 7 86

5
9 
10 

11~20

26~3821~25 

39

Figure. 4-28 AL Voice Edit Parameter 
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No. Name Description 
6 Voice Name  Sets the voice name being edited.  
7 Group display  

(Group Setting)  
For voices of program change that exist in the channels designated by AL 
setting, this parameter designates whether the same AL voice parameter is used 
for all voice, “ON, or AL voice parameters are used for each voice individually 
“OFF”. 
 
 
 
 
 
 
 

8 Enable AL display  
(AL enable setting)  

Designates whether AL is enabled, “ON”, or disabled “OFF.”  

9 Source display 
(Source selection)  

Designates whether Al voice parameter is attached to FM voice parameter, 
“FM”, Al voice parameter is attached to PCM voice parameter, “PCM”, or Al 
voice parameter is attached to Noise, “Noise.”  

10 Resonance  
(Resonance setting) 

Designates resonance.  

 
 
No.11 to 21 (Filter EG) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

No. Name Description 
11 Filter setting graph display Shows Fc0 to Fc4, FAR, FDR, FSR and FRR on the sequential line 

graph. Click and drag the point of Fc0 to Fc4 with mouse to directly edit 
the graph. FAR, FDR, FSR and FRR change in accordance with the 
edition. 

11 Fc0 display 
( KeyOn cut off frequency) 

Designates cutoff frequency change rate in attack state.  

12 FAR 
(Attack state cutoff frquency change rate) 

Designates cutoff frequency change rate in attack state.  

13 Fc1 display  
(Attack end cutoff frequency) 

Designates cutoff frequency at attack end. 

14 FDR display 
 (Decay state cutoff frequency change rate) 

Designates cutoff frequency change rate in decay state. 

15 Fc2 display 
 (Decay end cutoff frequency)  

Designates cutoff frequency at decay end. 

16 FSR display  
 (Sustain state cutoff frequency change rate) 

Designates cutoff frequency change rate in sustain state. 

17 Fc3 display  
 (KeyOff cutoff frequency)  

Designates cutoff frequency at KeyOff start. 

12 

13 15 17 19 21 

14 16 18 20

11 

When Paste operation is performed for voice parameters for which Group 
is set on Voice Assign Map, only AL voice parameter is changed for all 
voices of program change that exist in the channel designated by AL 
setting. For FM/PCM voice parameters, only the relevant voices are 
changed. 
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No. Name Description 
18 FRR display 

 (Release state cutoff frequency change rate) 
Designates cutoff frequency change rate in release state. 

19 Fc4 display  
 (Release cutoff frequency) 

Designates cutoff frequency at release. 

20 Key Follow  
 (Key follow setting) display 

Designates whether the setting of key follow for cutoff frequency 
(increases cutoff frequency according to the advance to upper interval. 

 
 
No.22 to 26 (LFO) 
 
 

 

 

 

 

 

 
No. Name Description 
22 LFO Enable display  

(LFO setting) 
 

Designates whether LFO is enabled, “ON”, or disabled, “OFF” for cut off 
freuqency. When a check is placed, LFO is enabled, where Freq, Depth or 
Mode can be changed. When a check is not placed, there parameters cannot be 
changed. 

23 LFO Reset display  
(LFO reset setting) 

Designates whether initial phase of LFO is reset, “ON” or not reset, “OFF”. 
 
 
 
 

24 LFO Mode display  
(LFO mode setting) 

Designates mode of LFO. 

25 LFO Freq. display  
(LFO frequency setting) 

Selects frequency of LFO. 

26 LFO Depth display  
(LFO depth setting) 

Selects depth of cutoff frequency of LFO. 

 
 
No.27 to 38 (Freq Fix) 
 
 
 
 
 
 
 
 
 

 

 
No. Name Description 

LFO 
27 Freq.FIX 1 Enable  

(Fixed frequency enabled setting 
operator 1) 

Designates whether fixed frequency of operator 1 is enabled, “ON” or 
disabled, “OFF.” 
When OFF, Key and Fine cannot be designated. 

28 Freq. FIX 1 Key  Designates key number of fixed frequency of operator 1. 

22 

24 

25 

26 

23 

27 “Op.1 Enable” 
30 “Op.2 Enable” 
33 “Op.3 Enable” 
36 “Op.4 Enable” 

 28, 31, 34, 37 “Key Setting” 

29, 32, 35, 38 “Fine Setting” 

When LFO Mode is “S&H”, CutOff frequency randomly changes, 
therefore this Reset function does not effect. 
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(Fixed frequency key setting 
operator 1) 

29 Freq. FIX 1 Fine  
(Fixed frequency fine setting 
operator 1) 

Designates fine pitch of fixed frequency of operator 1. 

30 Freq.FIX 2 Enable 
(Fixed frequency enabled setting 
operator 2) 

Designates whether fixed frequency of operator 2 is enabled, “ON” or 
disabled, “OFF.” 
When OFF, Key and Fine cannot be designated. 

31 Freq. FIX 2 Key  
(Fixed frequency key setting 
operator 2)  

Designates key number of fixed frequency of operator 2. 

32 Freq. FIX 2 Fine  
(Fixed frequency fine setting 
operator 2)  

Designates fine pitch of fixed frequency of operator 2.  

33 Freq.FIX 3 Enable 
(Fixed frequency enabled setting 
operator 3) display 

Designates whether fixed frequency of operator 3 is enabled, “ON” or 
disabled, “OFF.” 
When OFF, Key and Fine cannot be designated. 

34 Freq. FIX 3 Key 
(Fixed frequency key setting 
operator 3)  

Designates key number of fixed frequency of operator 3. 

35 Freq. FIX 3 Fine  
(Fixed frequency fine setting 
operator 3)  

Designates fine pitch of fixed frequency of operator 3. 

36 Freq.FIX 4 Enable 
 (Fixed frequency enabled 
setting operator 4)  

Designates whether fixed frequency of operator 4 is enabled, “ON” or 
disabled, “OFF.” 
When OFF, Key and Fine cannot be designated.  

37 Freq. FIX 4 Key  
(Fixed frequency key setting 
operator 4)  

Designates key number of fixed frequency of operator 4. 

38 Freq. FIX 4 Fine 
 (Fixed frequency fine setting 
operator 4)  

Designates fine pitch of fixed frequency of operator 4. 
 
 
 
 
 
 
 

 

 

No.39 (KeyBoard) 
 
 
 
 

 

 

 
No. Name Description 

Keyboard 
39 Keyboard  By clicking a keyboard, voices during a editing can be displayed. 

For details about Keyboard, refer to the “Keyboard” in “FM Voice Edit 
Parameter.”  

 

The setting value of Freq.FIX is recalculated, when the “OK” button of 
Voice Edit is pushed, or when it moves to FM Voice Edit tab. Therefore, 
although some difference will come out of the setting value of Freq. 
FIX compared with the value set up first when Voice Edit is opened 
once again, playback sound becomes the same. 
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5. Supplemental Information 
 

5.1. Voice List 
 
5.1.1. MA-5 Native Normal Voice Map (FM16 mode 0 to 63) 
 

Bank MSB 124
Bank LSB 3～7

Pch# Inst Typ Inst Typ Inst Typ Inst Typ Inst Typ
0 GrandPno F4 User A User A ・・・User A User A
1 BritePno F4 User A User A ・・・User A User A
2 E.GrandP F4 User A User A ・・・User A User A
3 HnkyTonk F4 User A User A ・・・User A User A
4 E.Piano1 F4 User A User A ・・・User A User A
5 E.Piano2 F4 User A User A ・・・User A User A
6 Harpsi. F4 User A User A ・・・User A User A
7 Clavi. F4 User A User A ・・・User A User A
8 Celesta F4 User A User A ・・・User A User A
9 Glocken F4 User A User A ・・・User A User A

10 MusicBox F4 User A User A ・・・User A User A
11 Vibes F4 User A User A ・・・User A User A
12 Marimba F4 User A User A ・・・User A User A
13 Xylophon F4 User A User A ・・・User A User A
14 TubulBel F4 User A User A ・・・User A User A
15 Dulcimer F4 User A User A ・・・User A User A
16 DrawOrgn F4 User A User A ・・・User A User A
17 PercOrgn F4 User A User A ・・・User A User A
18 RockOrgn F4 User A User A ・・・User A User A
19 ChrchOrg F4 User A User A ・・・User A User A
20 ReedOrgn F4 User A User A ・・・User A User A
21 Acordion F4 User A User A ・・・User A User A
22 Harmnica F4 User A User A ・・・User A User A
23 TangoAcd F4 User A User A ・・・User A User A
24 NylonGtr F4 User A User A ・・・User A User A
25 SteelGtr F4 User A User A ・・・User A User A
26 Jazz Gtr F4 User A User A ・・・User A User A
27 CleanGtr F4 User A User A ・・・User A User A
28 Mute.Gtr F4 User A User A ・・・User A User A
29 Ovrdrive F4 User A User A ・・・User A User A
30 Dist.Gtr F4 User A User A ・・・User A User A
31 GtrHarmo F4 User A User A ・・・User A User A
32 Aco.Bass F4 User A User A ・・・User A User A
33 FngrBass F4 User A User A ・・・User A User A
34 PickBass F4 User A User A ・・・User A User A
35 Fretless F4 User A User A ・・・User A User A
36 SlapBas1 F4 User A User A ・・・User A User A
37 SlapBas2 F4 User A User A ・・・User A User A
38 SynBass1 F4 User A User A ・・・User A User A
39 SynBass2 F4 User A User A ・・・User A User A
40 Violin F4 User A User A ・・・User A User A
41 Viola F4 User A User A ・・・User A User A
42 Cello F4 User A User A ・・・User A User A
43 ContraBs F4 User A User A ・・・User A User A
44 Trem.Str F4 User A User A ・・・User A User A
45 Pizz.Str F4 User A User A ・・・User A User A
46 Harp F4 User A User A ・・・User A User A
47 Timpani F4 User A User A ・・・User A User A
48 Strings1 F4 User A User A ・・・User A User A
49 Strings2 F4 User A User A ・・・User A User A
50 Syn.Str1 F4 User A User A ・・・User A User A
51 Syn.Str2 F4 User A User A ・・・User A User A
52 ChoirAah F4 User A User A ・・・User A User A
53 VoiceOoh F4 User A User A ・・・User A User A
54 SynVoice F4 User A User A ・・・User A User A
55 Orch.Hit F4 User A User A ・・・User A User A
56 Trumpet F4 User A User A ・・・User A User A
57 Trombone F4 User A User A ・・・User A User A
58 Tuba F4 User A User A ・・・User A User A
59 Mute.Trp F4 User A User A ・・・User A User A
60 Fr.Horn F4 User A User A ・・・User A User A
61 BrasSect F4 User A User A ・・・User A User A
62 SynBras1 F4 User A User A ・・・User A User A
63 SynBras2 F4 User A User A ・・・User A User A

Default User Assignable

124
0

124
1

124
2

124
8

124
9
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5.1.2. MA-5 Native Normal Voice Map (FM16 mode 64 to 127) 
 

Bank MSB 124
Bank LSB 3～7

Pch# Inst Typ Inst Typ Inst Typ Inst Typ Inst Typ
64 SprnoSax F4 User A User A ・・・User A User A
65 Alto Sax F4 User A User A ・・・User A User A
66 TenorSax F4 User A User A ・・・User A User A
67 Bari.Sax F4 User A User A ・・・User A User A
68 Oboe F4 User A User A ・・・User A User A
69 Eng.Horn F4 User A User A ・・・User A User A
70 Bassoon F4 User A User A ・・・User A User A
71 Clarinet F4 User A User A ・・・User A User A
72 Piccolo F4 User A User A ・・・User A User A
73 Flute F4 User A User A ・・・User A User A
74 Recorder F4 User A User A ・・・User A User A
75 PanFlute F4 User A User A ・・・User A User A
76 Bottle F4 User A User A ・・・User A User A
77 Shakhchi F4 User A User A ・・・User A User A
78 Whistle F4 User A User A ・・・User A User A
79 Ocarina F4 User A User A ・・・User A User A
80 SquareLd F4 User A User A ・・・User A User A
81 Saw.Lead F4 User A User A ・・・User A User A
82 CaliopLd F4 User A User A ・・・User A User A
83 ChiffLd F4 User A User A ・・・User A User A
84 CharanLd F4 User A User A ・・・User A User A
85 Voice Ld F4 User A User A ・・・User A User A
86 Fifth Ld F4 User A User A ・・・User A User A
87 Bass &Ld F4 User A User A ・・・User A User A
88 NewAgePd F4 User A User A ・・・User A User A
89 Warm Pad F4 User A User A ・・・User A User A
90 PolySyPd F4 User A User A ・・・User A User A
91 ChoirPad F4 User A User A ・・・User A User A
92 BowedPad F4 User A User A ・・・User A User A
93 MetalPad F4 User A User A ・・・User A User A
94 Halo Pad F4 User A User A ・・・User A User A
95 SweepPad F4 User A User A ・・・User A User A
96 Rain F4 User A User A ・・・User A User A
97 SoundTrk F4 User A User A ・・・User A User A
98 Crystal F4 User A User A ・・・User A User A
99 Atmosphr F4 User A User A ・・・User A User A

100 Bright F4 User A User A ・・・User A User A
101 Goblins F4 User A User A ・・・User A User A
102 Echoes F4 User A User A ・・・User A User A
103 Sci-Fi F4 User A User A ・・・User A User A
104 Sitar F4 User A User A ・・・User A User A
105 Banjo F4 User A User A ・・・User A User A
106 Shamisen F4 User A User A ・・・User A User A
107 Koto F4 User A User A ・・・User A User A
108 Kalimba F4 User A User A ・・・User A User A
109 Bagpipe F4 User A User A ・・・User A User A
110 Fiddle F4 User A User A ・・・User A User A
111 Shanai F4 User A User A ・・・User A User A
112 TnklBell F4 User A User A ・・・User A User A
113 Agogo F4 User A User A ・・・User A User A
114 SteelDrm F4 User A User A ・・・User A User A

*1 115 WoodBlok F4 User A User A ・・・User A User A
*2 116 TaikoDrm F4 User A User A ・・・User A User A
*3 117 MelodTom F4 User A User A ・・・User A User A
*4 118 Syn.Drum F4 User A User A ・・・User A User A *1 : 50cent/halftone, #69 = F#4
*4 119 RevCymbl F4 User A User A ・・・User A User A *2 : 50cent/halftone, #69 = A2

120 FretNoiz F4 User A User A ・・・User A User A *3 : 50cent/halftone, #69 = C#4
121 BrthNoiz F4 User A User A ・・・User A User A *4 : 50cent/halftone

*5 122 Seashore F4 User A User A ・・・User A User A *5 : 20cent/halftone
*6 123 Tweet F4 User A User A ・・・User A User A *6 : 5cent/halftone
*7 124 Telphone F4 User A User A ・・・User A User A *7 : 10cent/halftone
*7 125 Helicptr F4 User A User A ・・・User A User A The voice, which is set to Pch# with "*"
*6 126 Applause F4 User A User A ・・・User A User A is treated as drum voice by key control
*5 127 Gunshot F4 User A User A ・・・User A User A judging. (User Bank is also.)

Default User Assignable

124
0

124
1

124
2

124
8

124
9

 
(*) Type F2: FM 2 Operator, F4: FM 4 Operator, P: PCM, A: F2/F4/P Assignable 
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5.1.3. MA-5 Native Normal Voice Map (FM32 mode 0 to 63) 
 

Bank MSB 124
Bank LSB 3～7

Pch# Inst Typ Inst Typ Inst Typ Inst Typ Inst Typ
0 GrandPno F2 User A User A ・・・User A User A
1 BritePno F2 User A User A ・・・User A User A
2 E.GrandP F2 User A User A ・・・User A User A
3 HnkyTonk F2 User A User A ・・・User A User A
4 E.Piano1 F2 User A User A ・・・User A User A
5 E.Piano2 F2 User A User A ・・・User A User A
6 Harpsi. F2 User A User A ・・・User A User A
7 Clavi. F2 User A User A ・・・User A User A
8 Celesta F2 User A User A ・・・User A User A
9 Glocken F2 User A User A ・・・User A User A

10 MusicBox F2 User A User A ・・・User A User A
11 Vibes F2 User A User A ・・・User A User A
12 Marimba F2 User A User A ・・・User A User A
13 Xylophon F2 User A User A ・・・User A User A
14 TubulBel F2 User A User A ・・・User A User A
15 Dulcimer F2 User A User A ・・・User A User A
16 DrawOrgn F2 User A User A ・・・User A User A
17 PercOrgn F2 User A User A ・・・User A User A
18 RockOrgn F2 User A User A ・・・User A User A
19 ChrchOrg F2 User A User A ・・・User A User A
20 ReedOrgn F2 User A User A ・・・User A User A
21 Acordion F2 User A User A ・・・User A User A
22 Harmnica F2 User A User A ・・・User A User A
23 TangoAcd F2 User A User A ・・・User A User A
24 NylonGtr F2 User A User A ・・・User A User A
25 SteelGtr F2 User A User A ・・・User A User A
26 Jazz Gtr F2 User A User A ・・・User A User A
27 CleanGtr F2 User A User A ・・・User A User A
28 Mute.Gtr F2 User A User A ・・・User A User A
29 Ovrdrive F2 User A User A ・・・User A User A
30 Dist.Gtr F2 User A User A ・・・User A User A
31 GtrHarmo F2 User A User A ・・・User A User A
32 Aco.Bass F2 User A User A ・・・User A User A
33 FngrBass F2 User A User A ・・・User A User A
34 PickBass F2 User A User A ・・・User A User A
35 Fretless F2 User A User A ・・・User A User A
36 SlapBas1 F2 User A User A ・・・User A User A
37 SlapBas2 F2 User A User A ・・・User A User A
38 SynBass1 F2 User A User A ・・・User A User A
39 SynBass2 F2 User A User A ・・・User A User A
40 Violin F2 User A User A ・・・User A User A
41 Viola F2 User A User A ・・・User A User A
42 Cello F2 User A User A ・・・User A User A
43 ContraBs F2 User A User A ・・・User A User A
44 Trem.Str F2 User A User A ・・・User A User A
45 Pizz.Str F2 User A User A ・・・User A User A
46 Harp F2 User A User A ・・・User A User A
47 Timpani F2 User A User A ・・・User A User A
48 Strings1 F2 User A User A ・・・User A User A
49 Strings2 F2 User A User A ・・・User A User A
50 Syn.Str1 F2 User A User A ・・・User A User A
51 Syn.Str2 F2 User A User A ・・・User A User A
52 ChoirAah F2 User A User A ・・・User A User A
53 VoiceOoh F2 User A User A ・・・User A User A
54 SynVoice F2 User A User A ・・・User A User A
55 Orch.Hit F2 User A User A ・・・User A User A
56 Trumpet F2 User A User A ・・・User A User A
57 Trombone F2 User A User A ・・・User A User A
58 Tuba F2 User A User A ・・・User A User A
59 Mute.Trp F2 User A User A ・・・User A User A
60 Fr.Horn F2 User A User A ・・・User A User A
61 BrasSect F2 User A User A ・・・User A User A
62 SynBras1 F2 User A User A ・・・User A User A
63 SynBras2 F2 User A User A ・・・User A User A

Default User Assignable

124
0

124
1

124
2

124
8

124
9
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5.1.4. MA-5 Native Normal Voice Map (FM32 mode 64 to 127) 
 

Bank MSB 124
Bank LSB 3～7

Pch# Inst Typ Inst Typ Inst Typ Inst Typ Inst Typ
64 SprnoSax F2 User A User A ・・・User A User A
65 Alto Sax F2 User A User A ・・・User A User A
66 TenorSax F2 User A User A ・・・User A User A
67 Bari.Sax F2 User A User A ・・・User A User A
68 Oboe F2 User A User A ・・・User A User A
69 Eng.Horn F2 User A User A ・・・User A User A
70 Bassoon F2 User A User A ・・・User A User A
71 Clarinet F2 User A User A ・・・User A User A
72 Piccolo F2 User A User A ・・・User A User A
73 Flute F2 User A User A ・・・User A User A
74 Recorder F2 User A User A ・・・User A User A
75 PanFlute F2 User A User A ・・・User A User A
76 Bottle F2 User A User A ・・・User A User A
77 Shakhchi F2 User A User A ・・・User A User A
78 Whistle F2 User A User A ・・・User A User A
79 Ocarina F2 User A User A ・・・User A User A
80 SquareLd F2 User A User A ・・・User A User A
81 Saw.Lead F2 User A User A ・・・User A User A
82 CaliopLd F2 User A User A ・・・User A User A
83 ChiffLd F2 User A User A ・・・User A User A
84 CharanLd F2 User A User A ・・・User A User A
85 Voice Ld F2 User A User A ・・・User A User A
86 Fifth Ld F2 User A User A ・・・User A User A
87 Bass &Ld F2 User A User A ・・・User A User A
88 NewAgePd F2 User A User A ・・・User A User A
89 Warm Pad F2 User A User A ・・・User A User A
90 PolySyPd F2 User A User A ・・・User A User A
91 ChoirPad F2 User A User A ・・・User A User A
92 BowedPad F2 User A User A ・・・User A User A
93 MetalPad F2 User A User A ・・・User A User A
94 Halo Pad F2 User A User A ・・・User A User A
95 SweepPad F2 User A User A ・・・User A User A
96 Rain F2 User A User A ・・・User A User A
97 SoundTrk F2 User A User A ・・・User A User A
98 Crystal F2 User A User A ・・・User A User A
99 Atmosphr F2 User A User A ・・・User A User A

100 Bright F2 User A User A ・・・User A User A
101 Goblins F2 User A User A ・・・User A User A
102 Echoes F2 User A User A ・・・User A User A
103 Sci-Fi F2 User A User A ・・・User A User A
104 Sitar F2 User A User A ・・・User A User A
105 Banjo F2 User A User A ・・・User A User A
106 Shamisen F2 User A User A ・・・User A User A
107 Koto F2 User A User A ・・・User A User A
108 Kalimba F2 User A User A ・・・User A User A
109 Bagpipe F2 User A User A ・・・User A User A
110 Fiddle F2 User A User A ・・・User A User A
111 Shanai F2 User A User A ・・・User A User A
112 TnklBell F2 User A User A ・・・User A User A
113 Agogo F2 User A User A ・・・User A User A
114 SteelDrm F2 User A User A ・・・User A User A

*1 115 WoodBlok F2 User A User A ・・・User A User A
*2 116 TaikoDrm F2 User A User A ・・・User A User A
*3 117 MelodTom F2 User A User A ・・・User A User A
*4 118 Syn.Drum F2 User A User A ・・・User A User A *1 : 50cent/halftone, #69 = F#4
*4 119 RevCymbl F2 User A User A ・・・User A User A *2 : 50cent/halftone, #69 = A2

120 FretNoiz F2 User A User A ・・・User A User A *3 : 50cent/halftone, #69 = C#4
121 BrthNoiz F2 User A User A ・・・User A User A *4 : 50cent/halftone

*5 122 Seashore F2 User A User A ・・・User A User A *5 : 20cent/halftone
*6 123 Tweet F2 User A User A ・・・User A User A *6 : 5cent/halftone
*7 124 Telphone F2 User A User A ・・・User A User A *7 : 10cent/halftone
*7 125 Helicptr F2 User A User A ・・・User A User A The voice, which is set to Pcj# with "*",
*6 126 Applause F2 User A User A ・・・User A User A is treated as drum voice by key control
*5 127 Gunshot F2 User A User A ・・・User A User A judging. (User Bank is also.)

Default User Assignable

124
0

124
1

124
2

124
8

124
9

 
(*) Type F2: FM 2 Operator, F4: FM 4 Operator, P: PCM, A: F2/F4/P Assignable 
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5.1.5. MA-5 Native Normal Drum Instrument (FM16 mode) 
 

Bank MSB 125
Pch# 3～8

Note# Inst Typ Inst Typ Inst Typ Inst Typ
24 Seq Click H F4 Seq Click H F4 User A ・・・User A
25 Brush Tap F4 Brush Tap F4 User A ・・・User A

@ 26 Brush Swirl F4 Brush Swirl F4 User A ・・・User A
27 Brush Slap F4 Brush Slap F4 User A ・・・User A

@ 28 Brush Tap Swirl F4 Brush Tap Swirl F4 User A ・・・User A
@ 29 Snare Roll F4 Snare Roll F4 User A ・・・User A

30 Castanet F4 Castanet F4 User A ・・・User A
31 Snare L P Snare L F4 User A ・・・User A
32 Sticks F4 Sticks F4 User A ・・・User A
33 Bass Drum L P Bass Drum L F4 User A ・・・User A
34 Open Rim Shot F4 Open Rim Shot F4 User A ・・・User A
35 Bass Drum M P Bass Drum M F4 User A ・・・User A
36 Bass Drum H P Bass Drum H F4 User A ・・・User A
37 Closed Rim Shot F4 Closed Rim Shot F4 User A ・・・User A
38 Snare M P Snare M F4 User A ・・・User A
39 Hand Clap F4 Hand Clap F4 User A ・・・User A
40 Snare H P Snare H F4 User A ・・・User A
41 Floor Tom L P Floor Tom L F4 User A ・・・User A
42 Hi-Hat Closed P Hi-Hat Closed F4 User A ・・・User A
43 Floor Tom H P Floor Tom H F4 User A ・・・User A
44 Hi-Hat Pedal P Hi-Hat Pedal F4 User A ・・・User A
45 Low Tom P Low Tom F4 User A ・・・User A
46 Hi-Hat Open P Hi-Hat Open F4 User A ・・・User A
47 Mid Tom L P Mid Tom L F4 User A ・・・User A
48 Mid Tom H P Mid Tom H F4 User A ・・・User A
49 Crash Cymbal 1 P Crash Cymbal 1 F4 User A ・・・User A
50 High Tom P High Tom F4 User A ・・・User A
51 Ride Cymbal 1 P Ride Cymbal 1 F4 User A ・・・User A
52 Chinese Cymbal P Chinese Cymbal F4 User A ・・・User A
53 Ride Cymbal Cup F4 Ride Cymbal Cup F4 User A ・・・User A
54 Tambourine F4 Tambourine F4 User A ・・・User A
55 Splash Cymbal P Splash Cymbal F4 User A ・・・User A
56 Cowbell F4 Cowbell F4 User A ・・・User A
57 Crash Cymbal 2 P Crash Cymbal 2 F4 User A ・・・User A
58 Vibraslap F4 Vibraslap F4 User A ・・・User A
59 Ride Cymbal 2 P Ride Cymbal 2 F4 User A ・・・User A
60 Bongo H F4 Bongo H F4 User A ・・・User A
61 Bongo L F4 Bongo L F4 User A ・・・User A
62 Conga H Mute F4 Conga H Mute F4 User A ・・・User A
63 Conga H Open F4 Conga H Open F4 User A ・・・User A
64 Conga L F4 Conga L F4 User A ・・・User A
65 Timbale H F4 Timbale H F4 User A ・・・User A
66 Timbale L F4 Timbale L F4 User A ・・・User A
67 Agogo H F4 Agogo H F4 User A ・・・User A
68 Agogo L F4 Agogo L F4 User A ・・・User A
69 Cabasa F4 Cabasa F4 User A ・・・User A
70 Maracas F4 Maracas F4 User A ・・・User A

@ 71 Samba Whistle H F4 Samba Whistle H F4 User A ・・・User A
@ 72 Samba Whistle L F4 Samba Whistle L F4 User A ・・・User A

73 Guiro Short F4 Guiro Short F4 User A ・・・User A
74 Guiro Long F4 Guiro Long F4 User A ・・・User A
75 Claves F4 Claves F4 User A ・・・User A
76 Wood Block H F4 Wood Block H F4 User A ・・・User A Only the voice attached "@" is react to
77 Wood Block L F4 Wood Block L F4 User A ・・・User A KeyOff.
78 Cuica Mute F4 Cuica Mute F4 User A ・・・User A Exclusion allotment of Key#42, #44, #46
79 Cuica Open F4 Cuica Open F4 User A ・・・User A Exclusion allotment of Key#71, #72
80 Triangle Mute F4 Triangle Mute F4 User A ・・・User A Exclusion allotment of Key#73, #74
81 Triangle Open F4 Triangle Open F4 User A ・・・User A Exclusion allotment of Key#78, #79
82 Shaker F4 Shaker F4 User A ・・・User A Exclusion allotment of Key#80, #81
83 Jingle Bells F4 Jingle Bells F4 User A ・・・User A In case also that voice is set to above
84 Bell Tree F4 Bell Tree F4 User A ・・・User A NoteNo. Of User Bank Exclusion.

2
125
0

125
1

User Assignable

125
9

Default

125

 
 

(*) Type F2: FM 2 Operator, F4: FM 4 Operator, P: PCM, A: F2/F4/P Assignable 
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5.1.6. MA-5 Native Normal Drum Instrument (FM32 mode) 
 

Bank MSB 125
Pch# 3～8

Note# Inst Typ Inst Typ Inst Typ Inst Typ
24 Seq Click H F2 Seq Click H F2 User A ・・・User A
25 Brush Tap F2 Brush Tap F2 User A ・・・User A

@ 26 Brush Swirl F2 Brush Swirl F2 User A ・・・User A
27 Brush Slap F2 Brush Slap F2 User A ・・・User A

@ 28 Brush Tap Swirl F2 Brush Tap Swirl F2 User A ・・・User A
@ 29 Snare Roll F2 Snare Roll F2 User A ・・・User A

30 Castanet F2 Castanet F2 User A ・・・User A
31 Snare L P Snare L F2 User A ・・・User A
32 Sticks F2 Sticks F2 User A ・・・User A
33 Bass Drum L P Bass Drum L F2 User A ・・・User A
34 Open Rim Shot F2 Open Rim Shot F2 User A ・・・User A
35 Bass Drum M P Bass Drum M F2 User A ・・・User A
36 Bass Drum H P Bass Drum H F2 User A ・・・User A
37 Closed Rim F2 Closed Rim F2 User A ・・・User A
38 Snare M P Snare M F2 User A ・・・User A
39 Hand Clap F2 Hand Clap F2 User A ・・・User A
40 Snare H P Snare H F2 User A ・・・User A
41 Floor Tom L P Floor Tom L F2 User A ・・・User A
42 Hi-Hat Closed P Hi-Hat Closed F2 User A ・・・User A
43 Floor Tom H P Floor Tom H F2 User A ・・・User A
44 Hi-Hat Pedal P Hi-Hat Pedal F2 User A ・・・User A
45 Low Tom P Low Tom F2 User A ・・・User A
46 Hi-Hat Open P Hi-Hat Open F2 User A ・・・User A
47 Mid Tom L P Mid Tom L F2 User A ・・・User A
48 Mid Tom H P Mid Tom H F2 User A ・・・User A
49 Crash Cymbal 1 P Crash Cymbal 1 F2 User A ・・・User A
50 High Tom P High Tom F2 User A ・・・User A
51 Ride Cymbal 1 P Ride Cymbal 1 F2 User A ・・・User A
52 Chinese Cymbal P Chinese Cymbal F2 User A ・・・User A
53 Ride Cymbal F2 Ride Cymbal F2 User A ・・・User A
54 Tambourine F2 Tambourine F2 User A ・・・User A
55 Splash Cymbal P Splash Cymbal F2 User A ・・・User A
56 Cowbell F2 Cowbell F2 User A ・・・User A
57 Crash Cymbal 2 P Crash Cymbal 2 F2 User A ・・・User A
58 Vibraslap F2 Vibraslap F2 User A ・・・User A
59 Ride Cymbal 2 P Ride Cymbal 2 F2 User A ・・・User A
60 Bongo H F2 Bongo H F2 User A ・・・User A
61 Bongo L F2 Bongo L F2 User A ・・・User A
62 Conga H Mute F2 Conga H Mute F2 User A ・・・User A
63 Conga H Open F2 Conga H Open F2 User A ・・・User A
64 Conga L F2 Conga L F2 User A ・・・User A
65 Timbale H F2 Timbale H F2 User A ・・・User A
66 Timbale L F2 Timbale L F2 User A ・・・User A
67 Agogo H F2 Agogo H F2 User A ・・・User A
68 Agogo L F2 Agogo L F2 User A ・・・User A
69 Cabasa F2 Cabasa F2 User A ・・・User A
70 Maracas F2 Maracas F2 User A ・・・User A

@ 71 Samba Whistle F2 Samba Whistle F2 User A ・・・User A
@ 72 Samba Whistle F2 Samba Whistle F2 User A ・・・User A

73 Guiro Short F2 Guiro Short F2 User A ・・・User A
74 Guiro Long F2 Guiro Long F2 User A ・・・User A
75 Claves F2 Claves F2 User A ・・・User A
76 Wood Block H F2 Wood Block H F2 User A ・・・User A Only the voice attached "@" is react to
77 Wood Block L F2 Wood Block L F2 User A ・・・User A KeyOff.
78 Cuica Mute F2 Cuica Mute F2 User A ・・・User A Exclusion allotment of Key#42, #44, #46
79 Cuica Open F2 Cuica Open F2 User A ・・・User A Exclusion allotment of Key#71, #72
80 Triangle Mute F2 Triangle Mute F2 User A ・・・User A Exclusion allotment of Key#73, #74
81 Triangle Open F2 Triangle Open F2 User A ・・・User A Exclusion allotment of Key#78, #79
82 Shaker F2 Shaker F2 User A ・・・User A Exclusion allotment of Key#80, #81
83 Jingle Bells F2 Jingle Bells F2 User A ・・・User A In case also that voice is set to above
84 Bell Tree F2 Bell Tree F2 User A ・・・User A NoteNo. Of User Bank Exclusion.

User AssignableDefault

125
9

125
0

125
1

125
2

 
 

(*) Type F2: FM 2 Operator, F4: FM 4 Operator, P: PCM, A: F2/F4/P Assignable 
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5.1.7. MA-5 Native Normal Drum Instrument (FM32 mode) 
 
 

WaveID Instrument
0 Bass Drum
1 Snare Drum
2 Tom Tom
3 Hi-Hat Closed
4 Hi-Hat Open
5 Ride Cymbal
6 Crash Cymbal
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5.2. Error Message 
 
 
5.2.1. Error Message at Input/Output 
 

Display Description of error Cause 
Can not open MA1(SMF) file. 
Illegal file format. 

MA1 file cannot be opened. Format of the 
file is not correct. 

Format of MA1 (MA5) is not correct for 
reading. 

Can not import from file. 
Bank Number is different from selected bank. 

File cannot be opened. Type of bank select 
is wrong. 

When importing tones of bank row in 
VoiceList, the type of bank select is wrong. 

Can not open voice file. 
Illegal file format. 

Tone file cannot be opened. Format of the 
file is not correct. 

Tone definition file format error 

Can not open MLD file. 
Can not open MLD Phrase L2 in L1 mode. 

Unable to open a MLD file. Phrase L2 can 
not open by L1 mode.  

Tried to open a Phrase L2 file by L1 mode. 

Can not save voice file. 
Illegal bank voice parameter. 

Tone file cannot be saved. The bank of 
voice bank parameter is not correct. 

Failed in exporting tones of bank row in 
VoiceList 

Can not open file. 
Illegal file format. 

File cannot be opened. Format of the file is 
not correct. 

An attempt was made to read a file with 
extension that is not supported. 

Can not convert. 
DLL: Can not create file. 

File cannot be converted. File cannot be 
made. 

File cannot be made due to an error. 

Can not convert. 
DLL: Output buffer overflow. 

File cannot be converted. It overflows 
from the buffer. 

Converted file overflows from buffer. 

Can not convert. 
DLL: Illegal format type. 

File cannot be converted. Format type is 
not correct. 

Invalid format identifier exists. 

Can not convert. 
DLL: Illegal parameter of function. 

File cannot be converted. Value of function 
parameter is not correct. 

Value of function parameter is abnormal. 

Can not convert. 
DLL: Illegal event. 

File cannot be converted. Even is not 
correct. 

There is an even that is not defined. 

Can not convert. 
DLL: Temporary buffer overflow. 

File cannot be converted. File overflows 
from temporary buffer. 

Temporary buffer is full. 

Can not convert. File size of MLD is out of 
range. (256000byte) 

Unable to convert a file. 
File size is over 256000 bytes. 

Tried to play a MLD exceeded 256000byte 
and to save.  

Can not save File. 
- File path exceed 260byte. 

Unable to save a file. Path of file name 
exceeds 260byte. 

When the path of file name exceeds 260byte.

Can not assure contents. 
Max Event Density must be under 1000 
byte/s. 

The contents cannot be guaranteed. 
The maximum instantaneous event density 
exceeds 1000.  

In the case of the maximum instantaneous 
event density exceeds 1000 (Byte/s). 

Can not assure contents. 
Average Event Density must be under 500 
byte/s. 

The contents cannot be guaranteed. 
Mean event density exceeds 500. 

In the case of mean event density exceeds 
500 (Byte/s). 

Can not save file. 
Illegal output stream. 

Unable to save MLD file. Output stream is 
uncorrected. 

Document can not be saved into MLD 
(SMF) file. 

Can not open file. 
Illegal file format. 

Unable to open MLD file. File format is 
uncorrected. 

Format is uncorrected at reading of MLD 
(SMF) file. 

Can not open MA1(SMF) file. 
Illegal file format. 

Can not open MA1 file. File format is not 
correct. 

Format is not correct at loading of MA1 
(MA5) file. 

Can not convert. 
Dll: Total length is less than 20(msec). 

File can not be converted. 
Total length is 20 or less mesc. 

Total length is too short (20 or less mesc) 
after converted to MFi. 

Can not convert. 
Program Change is specified at the timing of 
sounding notes. 

Unable to file convert. Program change 
exists during a sound generation. 

Program change is performed in a section 
between NoteOn of an arbitrary Note 
message and NoteOff. 

Can not convert file. 
PCM voice setting error : Invalid Loop point 
setting. 
Bank MSB/LSB: %u / %u  Pch: %u  
Note: %u 
(Displays Voice Name) 

Unable to save a file. The setting of Loop 
Point is incorrect. 

Setting of Loop Point is incorrect. 

Can not convert file. 
PCM voice setting error : Invalid End point 
setting. 
Bank MSB/LSB: %u / %u  Pch: %u  
Note: %u 
(Displays Voice Name) 

Unable to save a file. The setting of End 
Point is incorrect. 

End Point is incorrect. 
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Display Description of error Cause 
Can not convert file. 
PCM voice setting error : SR <= 1 and XOF 
is checked. 
Bank MSB/LSB: %u / %u  Pch: %u  
Note: %u 
(Displays Voice Name) 

Unable to save a file. XOF check is on SR 
<= 1.   

XOF check is on SR <= 1.   

Can not convert file. 
PCM voice setting error : DR = 0, SL != 0 
and XOF is checked. 
Bank MSB/LSB: %u / %u  Pch: %u  
Note: %u 
(Displays Voice Name) 

Unable to save a file. Checks is on DR = 0, 
SL != 0 and XOF. 

Checks is on DR = 0, SL != 0 and XOF. 

Can not convert file. 
PCM voice setting error: RR <= 1 and XOF 
is not checked. 
Bank MSB/LSB: %u / %u  Pch: %u  
Note: %u 
(Displays Voice Name) 

Unable to save a file. Check is not on RR 
<= 1 and XOF 

Check is not on RR <= 1 and XOF 

 
 
 
 
5.2.2. Error Message for Start-up 
 

Display Description of error Cause 
Can not open application. 
Application is already running. 

The application has already been started. An attempt was made to start MA-5 Authoring 
Tool that has already been started. 

Can not open application. 
MA5_AT.ini (initial) file not found. 

The application cannot be started. The ini file 
of MA-5 Authoring Tool does not exist. 

MA5_AT.ini does not exist.  

Can not open application. 
Illegal parameter of MA-5_AT.ini 
(initial) file. 

The application cannot be started. The 
parameter of ini file of MA-5 Authoring Tool is 
not correct. 

The setting of parameter of MA-5_AT.ini is 
not correct. 

 
 
 
 
5.2.3. Error Message for Internal Input/Output 
 

Display Description of error Cause 
Can not export to M5N 
Unexpected problem is occurred. 

M3N cannot be made. An unexpected problem 
has occurred. 

It was impossible to make M3N due to an 
unknown problem. 

Can not export to M5N 
RAM size overflow. 

M3N cannot be made. MA-5 RAM capacity is 
exceeded. 

RAM capacity is exceeded. 

 
 
 
 

5.2.4. Error Message for MIDI 
 

Display Description of error Cause 
Can not assign sound file. 
RAM size overflow. (total %u byte) 

A sound file is un-assignable. 
RAM size is exceeded. 

When RAM size is exceeded. 
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5.2.5. Error Message for Wave Data 
 

Display Description of error Cause 
Can not open sound file. 
Stereo sound file is not supported. 

Sound file cannot be opened. This is not 
compatible with stereophonic sound file. 

Conversion processing was stopped 
because WaveFile is stereophonic. 

Can not convert sound file. 
Unexpected problem is occurred. 

Sound file cannot be converted. Processing was stopped due to an unknown 
problem during WaveFile conversion. 

Can not assign sound file. 
Numbers of Wave Exceed 128. 

Sound file cannot be assigned. Because of no space WaveID on Voice List, 
process is interrupted. 

Can not assign sound file. 
Number of Wave exceed 32. 

Sound file cannot be assigned. Because of no space WaveID on 
VoiceAssignMap, process is interrupted. 

Can not convert sound file. 
Sampling Frequency is not supported.  
(Must be over 4k Hz) 

Sound file cannot be assigned. With Stream PCM Assign MAP When 
WaveFile of 8 bit PCM is read Sampling 
Frequency is under 4000Hz.  

Can not convert sound file. 
Sampling Frequency is not supported.  
(Must be under 16k Hz) 

Sound file cannot be converted. Sampling Frequency is over 16000Hz 
when WaveFile of Mono 4 bit ADPCM is 
read at Stream PCM Assign MAP 

Can not convert sound file. 
Sampling Frequency is not supported.  
(Must be 4k Hz) 

Unable to convert a sound file. When Wave File of Stereo 8bit PCM was 
read by Stream PCM Assign Map, 
Sampling Frequency was except 4000. 

Can not convert sound file. 
Sampling Frequency is not supported.  
(Must be under 48k Hz) 

Sound file cannot be converted. Sampling Frequency is over 48000Hz 
when WaveFile is read at Voice Edit/PCM.

Can not convert sound file. 
Sampling Frequency is not supported.  
(Must be over 4k Hz) 

Can not convert sound file. 
Sampling Frequency is not supported.  
(Must be over 4k Hz) 

Since Sampling Frequency of Wave File 
read by Voice Edit or PCM is less than 
4000, either of reservation and/or playback 
cannot be performed. 

Can not assign stereo sound file. 
Sound file is already assigned. 

Unable to assign a sound file. 
Other sound files are already assigned. 

By two continuations, it cannot register 
with Stream PCM Assign MAP. 

Can not assign stereo sound file. 
Over Wave ID. (ID 1-31) 

A sound file is un-assignable. 
Wave ID. (ID 1-32) is exceeded. 

Tried to register the Stream PCM of Stereo 
into Wave ID 32. 

Can not assign stereo sound file. 
Sound file is already assigned. 
 

Can not assign stereo sound file. Other 
sound file may be assigned already. 

Two files cannot be continuously registered 
into StreamPCMAssignMap. 

Sampling Frequency is not supported. 
–Delete sound file. 

Can not assign a sound file. 
Wave ID is overflowed (ID 1-31). 

Try to register Stream PCM of Stereo into 
Wave ID 32. 
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5.2.6. Error Message for User’s Operation 
 

Display Description of error Cause 
Can not paste voice parameter. 
Can not assign 4 operator on GM1 mode. 

Unable to paste a voice parameter. 4 operators are pasted from VoiceList to 
VAM. 

Can not play. 
Illegal output stream. 

Unable to playback. The playback is un-normal. 
 

Can not close Voice Edit. 
Please load wave file or check 'RM'.  

Unable to close a Voice Edit. Be sure to 
check RM, or load a Wave file. 

In state, either the voice wave load 
completed or RM unchecked, O.K button is 
selected. 

Can not close Voice Edit. 
Please load basic waveform. 

Unable to close Voice Edit. 
Please load a basic-waveform. 
 

When “O.K” is pressed in FM Voice Edit; 
in the condition of which one of WS15, 23, 
or 31 is selected and when one of operator 
1 or 4 is selected; 

Can not close clear. 
This basic waveform is used. 

Unable to clear. 
This basic waveform is used. 

When the correspond FM basic waveform 
is used by other operators (include others 
voice) 

Can not close Voice Edit. 
Invalid Loop point setting. 

Unable to close a Voice Edit. Loop Point 
setting is illegal. 

In case of the LP check shows an error. 

Can not close Voice Edit. 
Invalid End point setting. 

Unable to close a Voice Edit. End Point 
setting is illegal. 

In case of the EP check shows an error. 

Can not close Voice Edit. 
Setting Error : SR <= 1 and XOF is checked. 

Unable to close a Voice Edit. 
Setting is error: SR <= 1 and XOF is not 
checked. 

EG in case of LP=EP, or check boxes of 
LPL, and EPL show an error 

Can not close Voice Edit. 
Setting Error : DR = 0, SL != 0 and XOF is 
checked. 

Unable to close a Voice Edit. 
Setting is error: DR = 0, SL != 0 and XOF 
is checked. 

EG in case of LP=EP, or check boxes of  
LPL and EPL show an error 

Can not close Voice Edit. 
Setting Error : RR <= 1 and XOF is not checked. 

Unable to close a Voice Edit. 
Setting is error: RR <= 1 and XOF is not 
checked. 

EG in case of LP=EP, or check boxes of 
LPL and EPL show an error 

Can not check AL enable. 
Number of AL voice exceed16. 

Unable to check the AL Enable. Al voice numbers exceeds 16. 

Can not open help. 
Unexpected problem is occurred. 

Unable to open “Help”. 
The unexpected problem is occurred. 

A help is not opened on a certain problem. 

Can not open help. 
Help file doesn’t exist. 

Unable to open “Help”. 
There is no help file. 

Since there is no help file, a help is not 
opened. 

Can not reload SMF file. 
SMF file doesn’t exist. 

Unable to reload an SMF. 
There is no SMF. 

Since there is no SMF, an SMF is not 
reloaded. 

 
 
 
 
 
 
5.2.7. Other Error Message 
 

Display Description of error Cause 
Exit application. 
Unexpected problem is occurred. 

Application is ended because of an 
unexpected problem. 

Application is ended because of an 
unexpected problem. 
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5.3. Warning Message 
 
 
5.3.1. Warning Message at Input/Output 
 

Display Display Timing 
Note Number (115-127) in MLD is not supported. 
DLL: Note Message (#115-127) is ignored. 

Since the note message of 115 to 127 exists, output of note number 
is controlled. 

Can not convert. 
RAM size overflow. 

Make a trial calculation of RAM size consumption from all voice 
registered in VoiceAssginMap and the setting of Stream PCM 
Reserved in Preference; if the sum total of calculation is over 8176 
(Byte).  

More than one Note messages found on the same duration in a 
mono mode channel. 
Only the last Note message will be accepted. 

When two or more note messages exist in dulation: 0 in a 
mono-mode specification channel at the time of a MLD output.  
* Only the thing of last note-message is output (it is a filter at 
DLL). 

Can not convert. 
Max Event Density must be under 1000 byte/s. 

The maximum event density at the moment is over 100 (Byte/s) at 
the time of SMF Import.   

Can not convert. 
Average Event Density must be under 500 byte/s. 

When average event density is over 500 (Byte/s) at the time of 
SMF Import. 

Can not output Information to SMF. Invalid Information. Since the contents of Information are inaccurate, Information 
cannot be output to SMF. 

FM voice setting error: Invalid wave style Setting. 
- Set wave style '0' automatically. 

When opening MLD or a voice file, an unjust Wave style setting is 
found and it corrects to '0' automatically. 

Phrase L1 voice file. Can not import BankM:125 Pch#1 bank voice When the voice file for Phrase L1 is loaded in the Phrase L2 mode 
and the voice set of BM:125/Pch#:1 is read and thrown away. 

Number of assigned voices is exceed128. 
Can not output excess voices. 

When a 128 or more-tone is assigned to Voice Assign Map. 

Cue Point is adjusted automatically. When incorrect Start/StopPoint position and phrase mark was 
automatically adjusted. 

 
 
5.3.2. Warning Message for Start up 
 

Display Display Timing 
Automatically operated. 
System has been changed to use COM%d 

When a connection port is changed into the thing different from a 
setup. 

 
 
5.3.3. Warning Message for Wave Data 
 

Display Display Timing 
Size of the Stream Data exceed the limit. When the data size of StreamPCM is too big. 
Sampling fq exceed the limit. When sampling frequency of StreamPCM exceeds the range. 

 
 
5.3.4. Warning Message at User’s Operation 
 

Display Display Timing 
Exist editing document. 
Save the document? 

When it is going to cancel the application in the state where the voice 
under edit exists. 

Exist editing parameter. 
Save the voice parameter? 

When it is going to cancel the application in the state where the voice 
under edit exists. 

Loop/End Point is adjusted automatically. When LP/EP automatic control function starts to the timing which 
opens PCM Voice Edit. 

Can not export to Voice List. 
-Normal Voice=BankMSB:124 /BankLSB:0 /Pch#:0-127 
-Drum Voice=Bank MSB:125 /Pch#:0-1/Note#:13-91 

When default voices were exported from Voice Assign Map to Voice 
List.  
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5.4. Verification Message 
 
 
5.4.1. Verification Message for MIDI 
 

Display Display Timing 
Confirm operation. 
Send Bank Voice Message? (total 128 voice) 
Bank MSB/LSB: %u/%u 

At the time of voice transmission of the bank sequence in Voice 
List (Normal) 

Confirm operation. 
Send Bank Voice Message? (total 79 voice) 
Bank MSB/LSB: %u/%u 
Pch: %u 
Note: 13-91 

At the time of voice transmission of the bank sequence in Voice 
List (Drum) 

 
 
5.4.2. Verification Message at User’s Operation 
 

Display Display Timing 
Confirm operation. 
Send MA-5 Native Reset Message? 

When Reset in the option menu was clicked. 

Confirm operation. 
Sound file will be detached automatically. 

An attempt was made to check RM (ON) when a sound file is being 
loaded into the PCM Voice Edit dialog. 

Overwriting Voice List. 
Save the changed voice parameters? 

When Open Voice File in the File menu was selected. 

Overwriting Voice List. 
Save the changed data of Voice List? 

When the Import from Bank Voice in the VoiceList was selected. 

Overwriting Voice List. 
Save the changed voice parameters? 

When Preference in the Option menu was selected. 

Overwriting Stream PCM Assign Map. 
Export to Stream PCM File? 

When the Import from Stream PCM File In the Stream PCM Assign 
Map was selected. 

Loop / End Point is adjusted automatically. 
 

When rounding was made because of incorrect both Loop Point and 
End Point. 

Confirm Operation. 
Send all parameters of AT? 

When performing Send All Parameter. 

Do you want to delete this file? When file is deleted from File List Window. 
Sampling Frequency and Loop / End Point is adjusted 
automatically. 

Fs and LP/EP were automatically adjusted when a file of extended 
voice list file format (.vm3) is saved in MA-5. 

AL Noise Voice is changed into Preset Voice. AL Noise is changed to default voice when a file of extended voice 
list file format (.vm3) is saved in MA-5. 



MA-5 Authoring Tool User’s Manual                        Copyright© 2004-2006 Yamaha Corporation 
 

-78- 

 

5.5. Shortcut Key 
 
In MA-5 Authoring Tool, the following shortcut keys can be used. 
 
 
 
 
 
 
5.5.1. Shortcut Key for Common to Each Window 
 

Key Operation 
[ESC] Cancels an editing operation. 
[DEL] Deletes the event chosen. 
[CTRL]+ [F4] Closes an active editing window. 
[CTRL]+ [F6](or Tab) Changes an active window in the editing window opened on the 

application window. 
[Alt](or GRPH)+[ Tab] Opens an application window, while minimizing MA-5 authoring tool. 
[Alt](or GRPH)+[Space key] Opens an icon popup menu from the title bar of an application window.
[Alt](or GRPH)+[ -](Hyphen) Opens an icon popup menu from the title bar of an active editing 

window. 
[Alt](or GRPH)+ [F4] Closes application. 

 
 
 
5.5.2. Shortcut Key for Menu Bar 
 

Key Operation 
[Alt](or [GRPH])+ Letter key Executes the menu item corresponding to each letter key. For example, 

when pushes [E] key with pushing [Alt] (or [GRPH]), the pull-down menu 
of [Edit] menu will open. In addition, copy will be chosen when [C] key is 
pushed on it. 

[Alt](or [GRPH]) Moves cursor to [File] of menu bar. In this status, it is possible to move 
cursor to right and left by pushing the cursor key of computer keyboard, 
and move to up and down on the opened menu. 

 
 
 
5.5.3. Shortcut Key for Control Button 
 

Key Operation 
Start/Stop button [Space] 

 

Sign “+” means “with”. For example, “[CTRL] + [F4]” means that “Push [F4] key with pushing the [Ctrl] 
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5.5.4. Shortcut Key for File Menu 
 

Key Operation 
Open [Ctrl]+[O] 
Save [Ctrl]+[S] 
Import from SMF [Ctrl]+[L] 
Reload from SMF [Ctrl]+[R] 

 
 
 
5.5.5. Shortcut Key for Edit Menu 
 

Key Operation 
Copy [Ctrl]+[C] 
Paste [Ctrl]+[V] 
Undo [Ctrl]+[Z] 
Redo [Ctrl]+[Y] 
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